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Alapfogalmak 
 
Az adattárolás mértékegységei 
 

A számítógép világában ugyanolyan fontos szerep jut a mértékegységeknek, mint 
hétköznapi életünkben. A számítógépen leggyakrabban az adatok mennyiségét és 
tárolásukhoz rendelkezésünkre álló szabad kapacitás nagyságát mérjük. Az alábbiakban 
az adattárolás mértékegységeivel ismerkedünk meg. 
 
Nagy mennyiségű adatok mérése 
 

A számítógéppel végzett munkánk során több bájtból álló adathalmazokkal 
találkozhatunk. Ezért az adatmennyiségek mérésének megkönnyítéséhez a 
mértékváltásnál megismert előtagokat, az ún. prefixumokat használjuk. A 
mértékegységek váltószámait az alábbi táblázatban foglaltuk össze. 

 
1. táblázat 
Mértékegységek és adatmennyiségek 

 
 

 
 
Adatmennyiségek a gyakorlatban 
 

Az alábbiakban a könnyebb összehasonlíthatóság kedvéért a köznapi életből vett 
néhány példán keresztül szemléltetjük az adatok mennyiségét. 
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2. táblázat 
Adatmennyiségek gyakorlatban 
 

 
 
*A fájlméret nagyban függ az alkalmazott tömörítési eljárástól és minőségi beállítástól. 
A fenti táblázatból láthatjuk, hogy például egy szövegszerkesztőben megírt A4 oldal 
hosszúságú levél mérete mindössze néhány kilobájt lesz. Azonban ha levelünkbe egy kis 
képet szúrunk be, már ez is radikálisan megnövelheti az adatmennyiséget. 
 
 
A számítógép bekapcsolása 
 

A régebbi számítógépeknél fontos volt, hogy a különböző perifériákat a központi 
egység előtt indítsuk. Ma ennek nincs akkora jelentősége, de biztonsági okokból ajánlott 
a: nyomtató vagy egyéb perifériák, monitor, és végül a központi egység. Amennyiben 
hálózatos környezetben dolgozunk, ajánlott először a szerver bekapcsolása. 

 
Rendszerbetöltés 

 
A Microsoft Windows XP Professional indítása a telepítéstől függően lehet 

automatikus, vagy menüvezérelt (például ha egy gépen több operációs rendszert 
telepítünk), valamint a felhasználó szándéka szerint: 
 
§ Szokásos (minden szolgáltatás elindul)  
§ Hibakeresés, egyéb indítási lehetőségek elérése: F8 nyomógomb lenyomásával 

kezdeményezhető 
 

A számítógép bekapcsolása után, az operációs rendszer betöltődéséig a következő két 
folyamat a legjelentősebb: 

1. bekapcsolási önteszt, POST (Power-On Self Test): a számítógép 
bekapcsolásakor vagy újraindításakor (reset) lefutó program, amely ellenőrzi a 
rendszerbeállítások szerinti eszközök meglétét és működését. Betöltődik a 
videokártya- és az alaplapi BIOS.  
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2. boot-folyamat, boot-olás: az a folyamat, amikor a számítógép bekapcsolásakor az 
operációs rendszer az önteszt lefutása után valamely háttértárolóról a memóriába 
töltődik.  

Bejelentkezés 
 

Ha a számítógépen csak egy felhasználó van beállítva, akkor a számítógép 
automatikusan bejelentkezik. Ha azonban több, akkor a felhasználó név kiválasztása után 
tudunk bejelentkezni, esetlegesen jelszó begépelése után. A jelszó begépelése biztonsági 
okokból nem látszik, szöveg helyett pontok (•) jelennek meg. Ha elfelejtettük a 
jelszavunkat, a kérdőjelle klikkelve megjelenik az emlékeztető szöveg, amelyet a 
jelszavunk megadásánál ad(hat)unk meg. A legtöbb hiba a jelszó begépelésénél a CAPS 
LOCK billentyű véletlen lenyomásából, valamint a Z és Y billentyűk fordított 
helyzetéből adódik. A rovatok kitöltése után üssük le az Enter billentyűt, vagy kattintsunk 
az OK gombra. 

A Windows 95 és a Windows 98 legfeljebb 14 karakter hosszú jelszavak 
használatát támogatta. A jelszó Windows XP-ben legfeljebb 127 karakter hosszú lehet, és 
megkülönbözteti a nagy- és kisbetűket, tehát az "ezajelszó", "Ezajelszó", "EzAjElSzÓ" 
és "EZAJELSZÓ" jelszavak különbözőek. A biztonságos jelszó legalább nyolc karakter 
hosszú, tartalmaz kis- és nagybetűket, számokat és különleges karaktereket, és nem, vagy 
csak nehezen vezethető le értelmes magyar vagy angol szóból, például: 
"ewGf$aX4F2@1". Ha az ilyen jelszavak megjegyzésével gondunk van, át lehet hidalni 
egy értelmes szó betűinek hasonló karakterrel való helyettesítésével, például: 
"123Ez@jeL$Zo456". Így létrejött egy olyan jelszó, ami a fenti feltételeknek is 
megfelel. 
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1. kép 
Bejelentkezés Windows XP-ben 
 

 
 
A képernyő részei 
 

A Windows XP képernyőjének nagy részét a háttér, az asztal (desktop) tölti ki. 
Ezen a grafikus felületen egy-egy programot, fájlt, mappát, vagy egy program valamely 
szolgáltatását grafikus elemek azonosítanak. Ezek az ábrák az ikonok (icon).  Ezek 
sorakoznak egymás alatt és mellett az asztalon. A képernyő alsó részén végigfutó sáv 
elnevezése tálca (taskbar). 

A tálca bal sarkában a Start gomb (Start button), a jobb sarkában pedig az óra és 
egyéb szimbólumok találhatóak. 
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2. kép 
A képernyő részei - Microrosoft XP 
 

 

 
Rendszerinformációk 
 

Többféleképp állapíthatjuk meg, hogy milyen verziószámú a gépünkre telepített 
Windows operációs rendszer. A Start menü Futtatás (Start > Run) parancsát választva 
indítsuk el a winver.exe programot. Ezzel megtudhatunk a gépünkön futó Windows 
operációs rendszerről néhány alapinformáciüt (verziószám, felhasználó neve, telepített 
szervízcsomagok, stb.)  

Az Asztalon a Sajátgép ikonra az egér jobb gombjával kattintva, majd a 
Tulajdonságok (Properties) parancsot kiválasztva hasonló tartalmú információt 
kaphatunk, illetve a Sajátgép ablakában, ha az üres felületre klikkelünk a jobb gombbal, 
majd a megjelenő menüből szintén a Tulajdonságok (Properties) menüpontot választjuk 
ki. A megjelenő panelen a fenn említett adatok mellett megjelennek alap 
hardverinformációk (a processzor neve és teljesítménye, RAM memória mennyisége). 
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3. kép 
Rendszertulajdonságok 
 

 
 

A legrészletesebb információkat pedig a Start menü Futtatás (Start > Run) 
pontját választva, az msinfo32.exe diagnosztikai program futtatásával kaphatjuk. Ezen a 
panelen megjelennek a részletes harverinformációk, a szoftverre vonatkozó információk 
és az operációs rendszer beállításai is. 
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4. kép 
Rendszerinformációk 

 

 
 
Feladatok: 
1. Állapítsuk meg, hogy milyen operációs rendszer (és szervízcsomag) került telepítésre 

a számítógépünkön, majd írjuk be a D:/ECDL/Modul2/Alapadatok.doc 
dokumentumba a megfelelő helyre, majd mentsük el a változásokat. 

2. Állapítsuk meg a számítógépünk processzorteljesítményét, és a RAM mennyiségét, 
majd írjuk be a D:/ECDL/Modul2/Alapadatok.doc dokumentumba a megfelelő 
helyre, töltsük ki a Név és a Munkahely – Oktatási intézmény mezőket is, majd 
mentsük el a változásokat. 

 
Az egér kezelése 
 

Az egér a Windowsban használt leggyakrabbi adatbeviteli eszköz.  
A Windows operációs rendszerben az egér segítségével kurzort irányítunk a 

képernyőn. Kurzornak nevezzük azt a mutató eszköt, amely valamilyen aktuális pozíciót 
jelez a képernyőn. 

Kattintásnak (klikkelés) nevezzük az egér bal oldali gombjának a megnyomását 
az egér elmozdítása nélkül. Az egyszeri kattintást a kiválasztásoknál használjuk a 
leggyakrabban. Dupla kattintásnak nevezzük az egér bal gombjának kétszeri, rövid, 
egymásutánban történő megnyomását, az egér elmozdítása nélkül. A dupla kattintással 
mappákat nyitunk meg, illetve programokat, alkalmazásokat futtatunk. 

Húzás (vonszolás) funkciót az egérrel úgy tudjuk megvalósítani, hogy az egeret a 
bal gombjának a lenyomása mellett mozgatjuk.  
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Megkülönböztetünk: egérkurzort, szövegkurzort (a következő karakter helyét jelzi), és 
várakozási kurzort (homokóra). 
 
5. kép 
Különböző kurzorok 

 
 

Az ablakok 
 

Feladatok: 
1. Helyezzük át a Lomtárat a bal felső sarokba 
 
Az ablakok meghatározása és részei 
 

A Windows operációs rendszerben a futó alkalmazások egy téglalap alakú 
részben jelennek meg. Ezt a téglalapot ablaknak nevezzük (windosws=ablakok). 

 
6. kép 
A programablak részei  
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Munka több ablakkal  
 

Az egymás mellett futó programok közt többféleképpen válthatunk. A 
legkényelmesebb megoldás a Tálca használata. A Tálcán minden ablak neve megjelenik, 
így könnyen leolvasható, milyen programok is működnek pillanatnyilag, továbbá 
bármilyen ablakunkat előtérbe hozhatjuk a neki megfelelő címkére rákattintva. Ha jobban 
szeretjük a billentyűzetet használni, az ablakok között az ALT + TAB billentyűkkel is 
váltogathatunk. Tartsuk az ALT billentyűt folyamatosan lenyomva, és a TAB 
billentyűvel lépegessünk mindaddig, amíg a képernyő közepén megjelenő téglalapban a 
kívánt program ikonját kijelöljük, majd engedjük fel az ALT billentyűt.  

Ha a kívánt ablak egy része takarásban van, másik része azonban látszik a 
képernyőn, rákattinthatunk a kívánt ablak kilógó címkéjére vagy - ha az éppen takarásban 
van - az ablak bármely, lehetőleg üres területére. Megjegyzés: Ha egy ablakot azon a 
módon kívánunk előtérbe hozni, hogy az ablak tartalmára kattintunk, próbáljuk elkerülni, 
hogy az ablak valamely funkcionális részére (pl. a vezérlő gombokra) kattintunk, mert 
ezáltal esetleg nem kívánt parancsokat adhatunk ki. (pl. az ablak bezárása, lekicsinyítése, 
stb.)  

A billentyűzet leütéseinek hatására mindig az aktív ablakban jelennek meg a 
karakterek, és a vezérlőbillentyűk is az aktív ablakban futó alkalmazást vezérlik. Azt, 
hogy melyik ablakunk az aktív, azt egyrészt onnan láthatjuk, hogy a Tálcán az 
alkalmazáshoz tartozó gomb be van nyomva, másrészt az alkalmazás ablakának 
címkéjének színe eltérő a többi ablakétól.  

 
7. kép 
Váltás az aktuálisan futó  programok között 
 

 
 
Feladatok: 
1. Váltsunk ablakot mindegyik módszerrel 
 

Start menü 
 

A korábbi Windows verzióktól különböző, áttervezett Start menü intelligensebb 
és több testreszabási lehetőséget kínál. A Start menü funkciójuk alapján csoportosítva 
tartalmazza az elérhető programok és parancsok listáját. A Start menü jelzi, hogy ki van 
bejelentkezve. A leggyakrabban használt programokat automatikusan felveszi a menü bal 



 11 

sávjába, de természetesen bármeny telepített programot elérhetjük a Minden program 
alpontban.  

Alapesetben a Start menü tetején a felhasználói azonosító foglal helyet. Alatta a 
bal oldali sávban a külön felvett és az utoljára futtatott alkalmazások találhatóak. Minden 
program (All Programs) menüpont alatt a telepített programokat tudjuk indítani. A Start 
menüből elérhető a Sajátgép és a Vezérlőpult is. 

Ha az egér jobb gombjával a Start gombra kattintunk, és a Tallózás (Open) 
menüpontot választjuk, akkor módosítani tudjuk a Start menü tartalmát. Ezzel a 
Documents and Settings\felhasználónév\Start Menu könyvtárat nyitjuk meg. A 
legtöbb felhasználói program telepítése végén automatikusan elhelyezi parancsikonjait a 
Start menüben. Ezen programok gyorsindítóit, és az ezeket összefoglaló könyvtárakat 
tudjuk törölni a fenn említett könyvtár elésével, illetve a Start menü megnyitása után 
megjelenő ablakban. 
 
8. kép 
A Start menü  
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Főmenü 
 

A legtöbb Windows alkalmazás által nyújtott funkciók, lehetőségek a menün 
keresztül érhetőek el. Többféle menü is létezik, a főmenü az ablak fejléce alatt levő 
sorban helyezkedik el. A menü kifejezés az éttermi menü egyszerű példájából származik. 
Az egyes menük kategóriák szerint csoportosított, különféle menüpontokat, 
menüpontokat és beállítási lehetőségeket tartalmaznak.  

A menüsort mindig az ALT vagy az F10 billentyűvel aktiválhatjuk, a vezérlés 
ilyenkor a sorban az első, a Fájl (File) menüpontra kerül. A további menüpontok 
kiválasztásához a balranyíl vagy jobbranyíl billentyűt használhatjuk, de a menüsor 
ciklikusan körbejárható.  

Az egyes menüpontokhoz tartozó menüt legördíthetjük, ha megnyomjuk a lenyíl 
vagy felnyíl billentyűket, de használhatjuk az ENTER billentyűt is. A menüpontok 
billentyűparancsait kiválasztó billentyűknek nevezzük. Ezek lehetővé teszik, hogy 
gyorsan legördíthessünk egy menüpontot az ALT + kiválasztó betű megnyomásával. 
Például: az ALT + S az Eszközök, az ALT + F a Fájl menüpontot gördíti le. A 
billentyűparancsokat az aláhúzott betűk jelzik, így az Eszközök menü S betűje, míg a Fájl 
menü F betűje van aláhúzva – a kiválasztó billentyű nem feltétlenül a kezdőbetű! Néhány 
menüpont a menüből közvetlenül is elérhető egy-egy billentyűkombinációval, például az 
alkalmazások többségében az ALT + F4 közvetlenül, a Fájl menü használata nélkül 
bezárja az aktív alkalmazást ugyanúgy, mintha a Fájl menü Kilépés menüpontját 
választottuk volna.  
 
9. kép 
A Sajátgép főmenüje 
 

 
 
Eszköztár 
 

Az eszköztáron a leggyakrabban használt parancsok találhatóak meg, ikon 
formájában. 

A Windows XP-ben az eszköztár alapesetben csak néhány elemet tartalmaz, 
amellyel visszaléphetünk az előző helyre, hatástalaníthatjuk a visszalépést, 
feljebbléphetünk a mappa struktúrában, keresést indíthatunk, bekapcsolhatjuk a 
mappalistát a böngészősávban, illetve válthatunk a különböző nézetek között. Az 
eszköztár elemei módosíthatóak a Nézet menü Eszköztárak almenüjében (View > 
Toolbars). 
 
10. kép 
A Sajátgép eszköztára 
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Legördülő menü 
  

Az alkalmazások menüsorán lévő menüpontok ún. legördülő menüvel 
rendelkeznek, amely a kiválasztott menüpontnak megfelelő további választási 
lehetőségek listáját adja. A legördülő menü szó szerint a menüsor egy eleméből 
legördített menüt jelenti, amely közvetlenül az általunk választott menüelem alatt jelenik 
meg a képernyőn. Például a menüsor Fájl menüjéből megnyílik egy legördülő menü, 
amely egyebek mellett a következő menüpontokat is tartalmazza: Megnyitás, Mentés,  
A legördülő menü egy menüpontjának aktiválása általában az alábbi három dolog 
egyikéhez vezet:  
 
1. A kiválasztott menüpontnak megfelelő funkciót azonnal végrehajtja az alkalmazás, pl. 
kilép.  
2. Megnyílik egy párbeszédpanel és további információkat, vagy megerősítést kér, pl. 
Mentés esetén. Ezt a menüpont neve utáni három pont jelzi.  
3. Egy további almenü nyílik meg, amelyet a menüpont utáni jobbra mutató nyílhegy 
jelez.  
 
11. kép 
Legördülő menü a Sajátgép mappában 
 

 
 
 
Almenü 
 

A legördülő menükből meghívott, lépcsőzetesen megnyíló menüket almenünek 
nevezzük. Az almenüt a nyitó menüelem melletti jobbra mutató nyílhegy jelzi. Az 
ENTER vagy a jobbranyíl billentyű megnyomásával nyithatjuk meg a kiválasztott 
menüelem almenüjét, amely a menüelemtől jobbra vagy balra nyílik meg. A függőleges 
listában megjelenő további menüelemeket ugyanúgy használhatjuk, mint egy normál 
legördülő menüt. A lépcsőzetesen megnyíló menü bezárásához, azaz a nyitó 
menüponthoz való visszatéréshez használjuk a balranyíl billentyűt vagy az ESCAPE 
billentyűt. Az ESCAPE billentyűvel mindig egy szintet lépünk vissza a menüben, míg az 
ALT megnyomásával egy lépésben bezárhatjuk az összes aktív menüt.  
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12. kép 
Almenü a Sajátgép mappában 
 

 
 
 
Helyi menü 
 

A Windows operációs rendszer számos objektuma rendelkezik egy speciális 
menüvel, amely kimondottan az adott objektumra vonatkozó menüpontokat kínálja fel 
számunkra. Ezek arra szolgálnak, hogy a gyakran használt funkciókat könnyebben 
elvégezhessük. Az ilyen menütípust helyi menünek nevezzük, de néha Tulajdonságok 
menünek is hívják. Sok objektum rendelkezik helyi menüvel, pl. a Tálca, az Asztal 
ikonjai, a Sajátgép programban megjelenített fájlok és mappák mindegyike. A helyi menü 
mindig valahol az objektum közelében tűnik fel a képernyőn, ez az ún. felbukkanó 
menü. A helyi menüt általában az egér jobb gombjával klikkelve tudjuk megjeleníteni. 
 
13. kép 
Helyi menü a Helyi lemez mappájában 
 

 
 
Inaktív menüpont 
 

Előfordulhat, hogy egy legördülő menü egy vagy több menüpontja nem 
használható. Ezeket a menüpontokat "nem kiválaszthatónak" nevezzük. Feliratuk szürke, 
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míg a többié fekete. Az aktuális pillanatban ezek az elemek nem használhatóak, mivel a 
hozzájuk tartozó menüpontok valamilyen okból nem hajthatók végre. Például a Word 
program Szerkesztés menüjének Beillesztés menüpontja nem érhető el addig, amíg nincs 
mit beilleszteni, az csak a Másolás vagy Kivágás parancsok kiadása után lesz elérhető.  

 
14. kép 
Inaktív menüpontok a Helyi lemez Szerkesztés menüjéből 

 

 
 
 

Keresés 
 
Ha elfelejtettük, hogy hol találjuk meg egyik vagy másik fájlunkat, vagy 

mappánkat, amelyre éppen szükségünk van, használjuk a Start menü > Keresés > 
Fájlok vagy mappák parancsát (Start > Search > Files or folders), vagy az F3 
gyorsbillentyűt. Az első lépésben meg kell határozni, hogy milyen típusú 
dokumentumokat keresünk. A következő választási lehetőségeink vannak: Képet, zenét 
vagy videót (Picture, music, or video); Documents (Word processing, spreadsheet, 
etc.) (Dokumentumok (szöveges, táblázat, stb.); Fájlt vagy mappát (All Files and 
folders), Computers or peoples (Számítógépeket vagy embereket). 

Leggyakrabban a Fájlt vagy mappát (All Files and folders) keresési opciót 
használjuk. Az opciót kiválasztva a következő panelen A fájlnév egésze vagy része: (All 
or part of file name:) cím alatt található kitöltőmezőben a dokumentumok nevére tudunk 
rákeresni. A Windows minden olyan fájl nevét kilistázza, amelynek nevében a keresett 
szó vagy szótöredék szerepel. Ha csak a pontosan egyező nevű elemeket keressük, tegyük 
idézőjelbe a fájl vagy mappa nevét.  

Az Egy szó vagy kifejezés a dokumentumban (A word or phrase in the file) 
felirat alatti kitöltőmezőbe a dokumentum belső tartalma alapján tudunk keresni. Így 
megtalálhatunk olyan dokumentumokat is, amelyeknek nem tudjuk a nevét, csak a 
tartalmát. 

A Keresés helye (Look in) rovatban választhatjuk ki, hogy melyik mappában 
keresünk. Ha nem tudjuk biztosan, hogy melyik meghajtón van a keresett adat, válasszuk 
a Sajátgépet, így a Windows az összes elérhető meghajtón fog keresni.  

Bonyolultabb keresésekhez megadhatunk további paramétereket: Mikor volt 
módosítva? (When was it modified): Nem emlékszem (Don`t remember), A múlt 
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héten (Within the las week), A múlt hónapban (Past month), A múlt évben (Within 
the past year), Dátum megadása (Specify dates) 

Mekkora a mérete  (What size is it): Nem emlékszem (Don`t remember), 
Kicsi (100 KB-nál kisebb) (Small less than 100 KB), Közepes (1 MB-nál kisebb) 
(Medium less than 1 MB), Nagy (1 MB-nál nagyobb) (Large more than 1 MB), 
Adott méret (KB) (Specify size in KB) 

További beállítások (More advanced option): Keresés a rendszermappákban 
(Search system folders), Keresés a rejtett fájlok és mappák között (Search hidden 
files and folders), Keresés almappákban (Search subfolders), Kis- és nagybetűk 
megkülönböztetése (Case sensitive), Keresés a szalagos biztonsági másolatokban 
(Search tape backup). 

Az utolsó módosításra vonatkozó keresésnél természetesen kulcsfontosságú 
szerepet játszik az, hogy a számítógép órája helyes időt mutasson. 

Helyettesítő (joker) karakterek ugyanúgy használhatók egy fájlnév 
meghatározásánál, mint annak idején a DOS korszakban. A * karakter tetszőleges számú, 
míg a ? egy karaktert helyettesít. Állományokra leghatékonyabban a kiterjesztés 
meghatározásával tudunk keresni (pl.: doc, exe, ppt) 

A keresés elvileg működik az Interneten is, de erre egy internetes keresőoldal 
(google) az ajánlott. 
 
15. kép 
Keresés panel  
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16. kép 
Keresés panel – fájl vagy mappa keresése 
 

 
 
Feladatok:  
1. Keressünk rá az ECDL mappára 
2. Helyettesítsük az egyes karaktereket kérdőjellel, ismételjük meg a keresést 
2. Listázzuk ki az összes doc állományt a D: meghajtón 
3. Keressünk rá azokra az állományokra, a D meghajtón, amelyeket az elmúlt héten 
módosítottunk 
4. Listázzuk ki az összes txt kiterjesztésű állományt az ECDL mappákból és 
almappákból, amelyek tartalmaznak ecdl szöveget 
5. Keressünk rá azokra az állományokra, amelyek 20 MB-nál nagyobbak a 
D:\ECDL\Modul2 mappában 
6. Keressünk 100 Mb-nál nagyobb fájlokat az összes meghajtón 
 

A Tálca (Taskbar) 
 

A Tálca (Taskbar) alaphelyzetben a képernyő alsó szélén, keskeny, egy sornyi 
sávként helyezkedik el, amely mindig látható marad.  

A Tálca elhelyezkedését, méretét azonban megváltoztathatjuk. A Tálca felületére 
kattintva az egér húzásával áthelyezhetjük a bal, vagy a jobb oldalra, illetve a képernyő 
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tetejére. A Tálca szélét az egérrel megfogva (az egér ekkor egy függőleges, kétirányú 
nyíllá változik) a Tálcát magasabbra vagy alacsonyabbra változtathatjuk. Ezzel a 
módszerrel a Tálcát el is rejthetjük, a magasságát nullára állítva (ez azonban nem 
tanácsos). A Tálca megjelenését megváltoztathatjuk a Start menü - Beállítások - Tálca 
paranccsal (Control Panel > Taskbar and Start Menu), a Vezérlőpulton a Tálca és 
Start menü parancsot választva, vagy a Tálcára az egér jobb gombjával kattintva, a 
Tulajdonságok (Properties) paranccsal.  

A Tálca zárolása (Lock the Taskbar) jelölőnégyzet bejelölésével lezárjuk a 
tálcát, és nem tudjuk módosítani a zárolás feloldásáig (a gyorsindítókat, a tálca méretét és 
elhelyezkedését nem tudjuk módosítani).  

Az Automatikus rejtés (Auto-hide the Taskbar) opciót bekapcsolva azt érjük 
el, hogy a Tálca minden esetben eltűnik, ha nem használjuk, így több helyet adva 
alkalmazásainknak. Ha a Tálcát használni szeretnénk, húzzuk az egérmutatót a képernyő 
megfelelő széléhez, ahol a Tálca automatikusan meg fog jelenni.  

A Mindig látható (Keep the taskbar on the top of other windows) opcióval 
biztosíthatjuk, hogy a Tálca mindig az ablakok felett maradjon, így semmi sem takarja. A 
többi opcióval szabályozhatjuk, hogy a Start menüben kis vagy nagy ikonok 
szerepeljenek, a csoportosításukat, a nem aktív ikonok megjelenítését, illetve azt, hogy az 
óra látható legyen-e a Tálca szélén. 

A Hasonló gombok csoportosítása a Tálcán (Group similar taskbar buttons) 
segítségével a hasonló alkalmazások gombjai csoportosítva jelennek meg. Ezekre 
gombokra klikkelve válik láthatóvá a tartalom, egy legördülő menü formájában. 

A gyorsindítás megjelenítése (Show Quick Launch) jelölőnégyzettel a 
gyorsindító menüt tudjuk megjeleníteni illetve eltüntetni.  

Módosítható ezen kívül a tálca mérete és helyzete is, de ezek a módosítások csak 
nem zárolt állapotban történhetnek meg. 
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17. kép 
A Tálca és a Start menü tulajdonságai – a Tálca beállításai 
 

 
 
 
Feladatok:  
1. Változtassuk meg a tálca tulajdonságait 
2. Helyezzük át a tálcát a képernyő olalaira, és a tetejére, ezután állítsuk vissza 
alaphelyzetbe 
3. Változtassuk meg a tálca méretét, ezután állítsuk vissza alaphelyzetbe 
4. Illesszük be a D:/ECDL/modul2/Alapadatok.doc dokumentumba a meghatározott 
képet, majd mentsük el a változásokat. 
 

Programok és alkalmazások futtatása (indítása) 
 

A Futtatás (Run) parancs segítségével lehetőségünk nyílik olyan programok 
elindítására is, melyek a Programok menüben nem szerepelnek. A Futtatás parancs 
kiválasztása után meg kell adnunk a kívánt program elérési útvonalát a Tallózás 
(Browse). Néhány program esetében nincs szükség az útvonal meghatározására, 
elegendő az alkalmazás nevének a begépelése (calc – Számológép). 
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A futtatás másik módja, ha a háttértárunkon megkeressük a futtatni kívánt 
állományt, és duplán kattintunk a megfelelő fájlra. 
 
 
18. kép 
A Tálca és a Start menü tulajdonságai – a Tálca beállításai 
 

 
 
 
Feladatok:  
 
1. Futassuk a Számológép (Calculator) alkalmazás a Futtatás (Run) parancs 

segítségével – Calc. Zárjuk be az alkalmazást 
2. Futassuk a Jegyzettömb (Notepad) alkalmazást a Futtatás parancs (Run) – 

Notepad. Zárjuk be az alkalmazást 
3. Futtassuk a Word alkalmazást a tallózás parancs segítségével (Program Files) 
4. Futtasuk a D:/ECDL/modul2/szabadka.exe állományt, mindkét módon. Zárjuk be az 

alkalmazást 
 

Telepítés 
 

A telepítés-intsallálás (gyakran lehet találkozni az angol installation és setup 
kifejezésekkel) az a folyamat, amikor egy alkalmazás vagy operációs rendszer a 
számítógépre kerül. A folyamatot végrehajtó programok elkészítése külön 
programozással vagy telepítőkészítő programok segítségével történik. Maga az eljárás 
gyakran részben vagy egészében testreszabható (például a célkönyvtár, telepítendő 
összetevők, parancsikonok stb.).A legtöbb program és operációs rendszer ilyen 
telepítőket használ, vannak azonban olyanok is, melyek egyszerűen átmásolják a 
szükséges fájlokat. 

A különböző dokumentumokat (Word, Excel, Mp3, Avi) nem kell telepíteni, 
elegendő, ha a háttértárunkra másoljuk. 

Egyes operációs rendszerek egyszerűen, telepítés nélkül, CD-ről, DVD-ről vagy 
pendrive-ról indíthatóak, és manapság egyre több népszerű programnak készítik el az 
ilyen (ún. portable) változatát. 

 
A telepítés alkalmával a következő történik: 
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§ fájlok és mappák másolódnak a célkönyvtárba és egyéb könyvtárakba (pl.: 

Windows könyvtár) 
§ kialakul az ugynevezett asszociációs viszony (médialejátszó asszociál a megfelelő 

kiterjesztésekre) 
§ parancsikonok másolódnak a Start menübe, az Asztalra illetve a Gyorsindítóba 

 

A telepítéssel ellentett művelet az eltávolítás (uninstall), amikor is törlődnek a 
célkönyvtárba, és az egyéb helyekre másolt állományok (és a célkönyvtár is), a 
gyorsindítók és a parancsikon, valamint megszűnik az asszociációs viszony is. A 
telepített alkalmazásokat mindig eltávolítás paranccsal (Vezérlőpul-Control Panel) 
távolítjuk el (nem manuális törléssel!!!). 
 
Feladatok: 
1. Telepítsünk a D:/ECDL/modul2/Telepites/kiskonyvtar_setup.exe telepítő segítségével, 
a D:/ECDL/modul2 célkönyvtárba 
2. Telepítsünk a D:/ECDL/modul2/Telepites/GoogleEarthWin.exe telepítő segítségével, a 
D:/ECDL/modul2 célkönyvtárba 
3. Telepítsünk D:/ECDL/modul2/setup.exe telepítő segítségével, a D:/ECDL/modul2 
célkönyvtárba. Majd nyissuk meg a Magyar Nepmese.avi fájlot az mv2 ljátszó 
segítségével, majd engedélyezzük ezt a lejátszót elsődleges lejátszóra az avi fájlok 
asszociációjára 
 

Ikonok, parancsikonok és gyorsindítók 
 

Ha egy programot több helyről szeretnénk indítani (asztal, start menü, 
gyorsindító), akkor ezt úgynevezett parancsikonokat (shortcut) létrohozásával tudjuk 
megvalósítani. Ezek az állományok valójában néhány byte hosszúak (az állomány elérési 
útvonalát, és ikonját tárolják), de rájuk klikkelve indíthatjuk a hozzájuk rendelt 
programot. 
 Parancsikonokat létre tudunk hozni úgy, hogy a valós programot szimbolizáló 
ikonra klikkelünk a jobb egérgombbal. Az így megjelenő helyi menüből válasszuk ki a 
Parancsikon létrehozása (Create Shortcut). A művelet hatására a kívánt helyen 
létrejön a parancsikon. A visszafelé gördülő nyíl különbözteti meg a valós 
programmásolatoktól, illetve az eredeti állománytól. A parancsikon létrehozása után 
áthelyezhető, másolható és átnevezhető. 
 Parancsikon létrehozható a helyi menü segítségével az Új menü Parancsikon 
(New > Shortcut) menüpontját választva. Ezután a háttértáron meg kell keresni, hogy 
hol helyezkedik el az eredeti állomány, a Tallózás (Browse) utasítás segítségével. Ezután 
meg kell határozni a gyorsindító nevét az Adja meg a parancsikon nevét (Type name 
of shortcut) mezőbe gépelve ezt (illetve elfogadva az operációs rendszer által felkínált 
megoldást). A Befejezés (Finish) gombot lenyomva hozzuk létre a parancsikont. 
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19. kép 
Parancsikon létrehozásának első lépése 
 

  
 

20. kép 
Parancsikon létrehozásának második lépése 
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 A Gyorsindítók (Quick Launch) ikonokkal is programok tudunk indítani, de egy 
külön helyen kapnak helyet (a tálcán, alapesetben a start gomb mellett jobbról). 
Indításukhoz a dubla klikkelés helyett, az egyszerű klikkelés szükséges. Létrohozásuk 
úgy történik, hogy parancsikonokat helyezünk át a gyorsindítás panelre. Ezután a 
sorrendjük cserélhető, törölhetőek, vagy áthelyezhetőek újra az asztalra. 
 
21. kép 
A Start gomb és a gyorsindítók 
 

 
 

 Az asztalon található ikonokat átrendezhetjük manuálissan (az ikonok 
áthúzásával), illetve rendezhetjük meghatározott szempontok szerint: Név (Name), 
Méret (Size), Típus (Type), illetve a Módosítás (Modified) szerint. Ezeket az opciókat 
úgy tudjuk elérni, ha az asztalra klikkelünk a jobb gombbal, és a helyi menüből az 
Ikonrendezés szempontjai (Arrange Icons By) almenüt választjuk ki. 
 
22. kép 
Az Ikonrendezés szempontja 
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3. táblázat 
Ikonok a Microsoft XP-ben 
 

 
A Microsoft Windowsban leggyakrabban használt ikonok 

 

 Sajátgép (My Computer) 

 Hálózati helyek (My Network Places) 

 Lomtár (Recycle Bin) 

 Asztal megjelenítése (Show Desktop) 

 3,5”-es hajlékonylemez (3½ Floppy) 

 Helyi lemez (Local Disk) 

 CD-meghajtó, DVD-meghajtó (CD Drive, DVD Drive) 

 Cserélhető lemez (Removable Disk) 

 Dokumentumok (Documents) 

 könyvtár, mappa (Folder) 
 
Feladatok: 
1. Rendezzük a D:/ECDL/modul2 ikonjait a felsorolt szempontok szerint (határozzuk 
meg a legnagyobb méretűt, az utoljára módosítottat, és fordítva). Töltsük ki az 
D:/ECDL/modul2/Alapadatok.doc dokumentum rendezésre vonatkozó celláit, valamint 
illesszük be a lefényképezett ablakokat, majd mentsük el a változásokat. 
2. Készítsünk parancsikont a D:/ECDL/modul2/szabadka.exe állományból mindkét 
lehetséges módon (melyiket alkalmazzuk mikor?) 
3. Készítsünk a parancsikonból gyorsindítót, majd a gyorsindítóból parancsikont 
4. Készítsünk parancsikont a D:/ECDL/modul2/animation_tutorial_by_biro.avi fájlból, 
Kedvenc tutorialom néven 
5. Töröljük az elkészített ikonokat 
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A Súgó 
 

A Súgó és támogatás (Help and Support Centre) az operációs rendszer egyik 
szolgáltatása, melyből segítséget kaphatunk a Windows rendszer, vagy egy program 
használatához. A Windows általános használatához ad tanácsokat. Súgó azonban 
csaknem minden programban van, használatával hatékony segítséget kaphatunk a 
felhasználói programok használatához.  

Tippek:  

§ Az F1 billentyű lenyomásával bármikor előhívhatjuk az aktuális programhoz 
tartozó súgót.  

§ A legtöbb program a menüsorból is elérhetővé teszi a Súgó szolgáltatásait.  
§ Párbeszédablakokban további segítséget is kaphatunk:  
§ Ha elérhető, a Súgó gombra kattintva az adott művelet elvégzéséhez kaphatunk 

segítséget.  
§ A legtöbb párbeszédablak jobb felső sarkában látható  kérdőjel ikonra 

kattintva az egérmutató megváltozik. Ha ezután a párbeszédablak rovataira 
kattintunk, a kitöltéshez kaphatunk segítséget. A rövid leírás egy sárga mezőben 
jelenik meg.  

§ Ugyanezt a funkciót az egér jobb gombjával kattintva is előhívhatjuk. Ilyenkor 
kattintsunk a "Mi ez?" parancsra. A sárga téglalap területére kattintva 
visszatérhetünk a munkánkhoz.  

A Súgó alaptípusa egy kézikönyv-készletnek felel meg, ahol az egyes 
könyvekben tudunk keresni, és azok lapjait megnyitni. A Tárgymutatóban (Help Topic) 
keresve adott kulcsszavakhoz tartozó súgóoldalakat kereshetünk ki.  

A Keresés (Search) fülre kattintva azokat a súgóoldalakat tudjuk megkeresni, 
amelyek szövege az általunk keresett szót tartalmazza.  
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23. kép 
A Súgó 

 

A számítógépünkre telepített súgófájlok megtalálhatóak a Windows\Help 
rendszermappában, a *.chm és *.hlp kiterjesztésű fájlok közvetlenül is megnyithatóak.  

A tartalomjegyzék kezdőlapjához mindig visszatérhetünk a Kezdőlap  
gombra kattintva. A Keresés (Search) mezőbe beírt kulcsszó alapján kikerestethetjük a 
bennünket érdeklő súgótémaköröket, a tárgymutató bejegyzéset a Tárgymutató gombra 
kattintva, egy szó beírásával, vagy a lista görgetésével tekinthetjük meg. Egyes 
témakörök gyakran több bejegyzésnél is megtalálhatók. Egy szó vagy kifejezés összes 
előfordulásának megkereséséhez a Keresés mezőbe írjuk be a keresett szót vagy a 
kifejezést, majd kattintsunk a Keresés megkezdése  gombra, vagy nyomjuk meg az 
Enter billentyűt.  

A Windows XP súgórendszere HTML, a Web leírónyelve segítségével formázza 
és jeleníti meg a tudnivalókat. Internet kapcsolat esetén a hivatkozások nem csupán a 
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súgón belüli témakörökre korlátozódnak, megjeleníthetők a World Wide Weben található 
további, vagy a termékkel kapcsolatos legfrissebb tudnivalók is.  

A Súgó egyes témaköreit kinyomtathatjuk az eszköztár Nyomtatás  gombjára 
való kattintással, vagy ha a témakör szövegébe az egér jobb gombjával kattintva a 
Nyomtatás (Print) parancsot választjuk.  
 

 
Feladatok: 
1. Keressünk szöveget a Súgóban a Painttel kapcsolatosan, majd másoljuk a 
D:/ECDL/Modul2/Alapadatok.doc dokumentumba a megfelelő helyre, majd mentsük el a 
változásokat. 

 
Kilépés a rendszerből 

 
A rendszerből való kilépésnek többféle oka lehet, de a leggyakoribb azonban az, 

hogy befejeztük a munkánkat, és az adott számítógépen már nem kívánunk dolgozni.  
A kilépés több szempontból is fontos: egyrészt, ha a számítógépet ki akarjuk kapcsolni, 
szükséges, hogy ezt a Windows-nak is jelezzük. Ilyenkor a gép a még nem mentett 
adatokat lemezen tárolja, hogy a gép kikapcsolásakor ne forduljon elő adatvesztés vagy -
sérülés. Másrészt, ha a gépet nem is szeretnénk kikapcsolni, akkor is fontos, hogy 
kijelentkezzünk a számítógépes hálózatból, hogy ha majd másvalaki ül a gépünk elé, újra 
be kelljen jelentkeznie. Ezzel meggátolhatjuk, hogy valaki a hálózaton tárolt adatokhoz a 
mi nevünkkel és jelszavunkkal férjen hozzá.  
 
24. kép 
tartományhoz kapcsolódó számítógép leállítása 
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25. kép 
otthoni számítógép kikapcsolása 

 

 
 

 
A kilépéshez minden esetben a Start menü, Kikapcsolása (Start > Turn Off 

Computer) parancsát kell használni. Az ezután megjelenő ablakból választhatjuk ki a 
kívánt kilépési módot.  

Amennyiben munkánk befejeztével szeretnénk a számítógépet kikapcsolni, a 
Kikapcsolás (Turn Off) parancs használatával tudjuk ezt megtenni. A parancs után 
röviddel a Windows rendszer leáll, majd egy üzenettel tudtunkra adja, hogy a számítógép 
kikapcsolható. Fejlett energiagazdálkodású alaplappal (ACPI) rendelkező számítógépek a 
leállítás paranccsal a teljes kikapcsolást is végrehajtják, ez esetben külön üzenetet nem 
kapunk.  

Bizonyos esetekben szükség lehet a számítógép újraindítására. (pl. valamilyen 
alapbeállítás megváltoztatása után a rendszer igényelheti az újraindítást, hogy az új 
beállítás érvényt kapjon.) Ebben az esetben válasszuk az Újraindítás (Restart) 
parancsot. Ennek hatására a Windows rendszer végrehajtja a teljes leállási, majd a teljes 
indulási folyamatot. Ezután újra be kell jelentkeznünk, ha szeretnénk tovább dolgozni.  

Készenlét (Stand By) állapotban a számítógép egésze alacsony fogyasztású 
állapotra vált, amelyben a géphez csatlakoztatott eszközök (például a képernyő és a 
merevlemezek) kikapcsolnak, így a számítógép kevesebb áramot fogyaszt. Amikor újra 
használni szeretnénk a számítógépet, az gyorsan visszaáll készenléti állapotról normál 
üzemmódra, és az asztal pontosan úgy jelenik meg, mint akkor, amikor otthagytuk a 
gépet. A készenléti állapot különösen hasznos a hordozható számítógépek esetében, ahol 
a laptop energiájának megtakarítása lényeges szempont.  

Amikor egy adott gépen a munkánkat befejeztük és kikapcsolás nélkül a 
számítógépet otthagyjuk, elegendő kijelentkezni a rendszerből. A rendszerből a 
Kijelentkezés (Log Off) paranccsal jelentkezhetünk ki. Ezzel a Windows rendszerben 
visszajutunk a hálózati bejelentkezés ablakához, ahol - ha majd újra dolgozni kezdünk - 
meg kell adnunk a felhasználónevünket és jelszavunkat.  

Ha több felhasználó dolgozik egy számítógépen, a felhasználók közötti váltás 
során a ki- és bejelentkezések sok időt vesznek el. Ezt a Felhasználóváltás (Switch 
User) menüpont kiválasztásával tudjuk kezdeményezni. A gyors felhasználóváltás, a 
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tartományhoz nem csatlakozó Windows XP Home Edition és Windows XP Professional 
rendszerek szolgáltatása lehetővé teszi, hogy a számítógépről való kijelentkezés nélkül 
váltson a felhasználók között. Egy számítógépet több felhasználó oszthat meg és 
használhat párhuzamosan, és a váltásokhoz nem kell bezárni futtatott programjaikat.  
 

Adatszerkezet és fájlkezelés 
 
Bevezető 
 

Ha áttekintjük a Windows rendszer által használt adatszerkezet felépítését, 
láthatjuk, hogy a megszokott fa struktúra szerinti adattárolás kiindulópontja az Asztal 
(Desktop). Ebből nyílnak a Sajátgép (My Computer), Hálózatok (My Network Places) 
és a Lomtár (Recycle Bin) logikai mappái. Az Asztal mappában található objektumok 
természetesen a munkaasztalról is elérhetőek, de megjelennek a fájlkezelésre szolgáló 
eszközökben is.  
 
Sajátgép 
 

A Sajátgép (My Computer) logikai mappa tartalmazza a saját (lokális) helyi 
gépünk erőforrásait, úgymint lokális háttértárolóink meghajtóit (floppy lemez, 
merevlemez, CD-ROM meghajtókat, illetve a helyi hálózat által nyújtott hálózati 
meghajtókat) a Dokumentumok és Megosztott dokumentumok mappát és saját gépünk 
beállításait tartalmazó Vezérlőpult (Control Panel) logikai mappát. 

A háttértárolóink azonosítására az abc betűit használjuk. A floppylemezek 
meghajtóit (egyre ritkábban kerülnek beépítésre) A és B betűvel jelöljük. A 
merevlemezek jelölése a C betűtől kezdődik. A betűk után pont kerül, ezzel jelezve, hogy 
nem programról van szó (C:, D:, stb). 

A nagyobb kapacitású merevlemezeket azonban általában particionálják, több 
részre osztják fel. Így ezeknek a felosztott merevlemezeknek a részeit külön 
meghatjóként kezeli az operációs rendszer is (például: egy merevlemezt C: és D: 
partícióra osztanak). 
 
Mappák és állományok 

 
A számítógépen tárolt adatokat különböző csoportokba rendezzük. Ezeket 

csoportokat mappának (folder) nevezzük. A mappák alkotják a mappastruktúrát vagy 
régebbi nevén könyvtárstruktúrát Ezek a mappák lehetővé teszik, hogy az egyes 
állományainkat, bizonyos logikai vonalat követve, a legkönnyebben megtaláljuk. Az 
állományainkat rendezhetjük például témakörök szerint: szöveges dokumentumok, 
táblázatok, képek, filmek, zenék. Ezeket a kategóriákat is rendezhetjük további 
csoportokba (például a képeinket: képek a nyaralásról, képek a telelésről, képek otthon, 
képek a munkahelyünkről, stb.). 

Az adott meghajtón található kiindulási pontot, illetve legmagasabb szintet 
főkönyvtárnak vagy gyökérkönyvtárnak (root directory) nevezzük. A főkönyvtárból 
elérhető mappákat első szintű mappáknak (alkönyvtárak) nevezzük, az ebből nyíló 
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mappákat második szintű mappáknak nevezzük. Természetesen ezek az alkönyvtárak 
tetszés szerint létrehozhatóak, tetszőleges szinteken. 
 Ha a számítógépünk háttértárolóit egy polcon található mappáknak csoportjaként 
képzeljük el, akkor ezekben a mappákban helyet kapó dokumentumok (papírok, iratok) 
lennének az egyes állományok vagy fájlok (file). Az operációs rendszer szempontjából 
egy állomány csak bináris jegyek sorozata. Az állományt használó program feladata, 
hogy megértse az adatok jelentését az álományon belül, és megjelenítse a tartalmát a 
felhasználó számára értelmezhető módon (szöveg, kép, hang, multimédia) 

Egyes esetekben szükséges lehet közvetlenül a mappákra vagy az állományokra 
hivatkozni (például a futtatás panelen). Ilyenkor az utasítás a meghajtó meghatározásával 
kezdődik, az egyes elemeket pedig a \ jellel választjuk el egymástól. A hivatkozás ilyen 
módját elérési útvonalnak nevezzük. A gyakorlatban a következő lenne egy elérési út: 
D:\Tanitokepzo\Masolasok\hardverismeret.doc. 
 
26. kép 
Mappastruktúra (fa/tree szerkezet) 
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Kiterjesztések 
 

A fájvégződésnek vagy kiterjesztésnek nevezzük a fájl egész nevének utolsó 
három vagy négy betűjét (számát). A fájlvégződés a fájlban a pont után következnek. 
Például a szeminarium.doc fájlnál a doc a fájl kiterjesztése.  

A kiterjesztéseket az operációs rendszer használja arra, hogy meghatározott 
kiterjesztésű fájlokat rendel programhoz, programokhoz. Ezt a viszonyt asszociációs 
viszonynak nevezzük. A szeminarium.doc esetében például a Word asszociál a doc 
kiterjesztésre. Ha duplán klikkelünk az állományra, akkor megnyitja az említett program, 
és segítségével tudjuk szerkeszteni is. 

Az asszociációs viszonyt a adott fájlra jobb gombbal klikkelve a Társítás (Open 
with) tudjuk módosítani. Itt tudunk hozzárendelni programot a fájlhoz. Ha az adott 
program nem szerepel a listán, akkor a Program választása (Choose Program) 
utasítással tudjuk meghatározni a társítani kívánt programot (futtatható fájl 
megmutatásával).  

 
27. kép 
Társítás, jobb klikkelés a fájlra – helyi menü 

 
 

 
 

 
Egy tetszőleges ablak Eszközök (Tools) menüjéből a Mappa beállításai (Folder 

Option) menüpontra klikkelve részletesebben meg tudjuk határozni a fájlok és a 
programok közti viszonyt. A Fájltípusok (File Types) fül alatt megtalálható az összes, 
operációs rendszerünk által, ismert fájltípus. Egyenként ezekre klikkelve, majd a 
Speciális (Advanced) gombot választva tudunk programokat rendelni a fájlok 
megnyitásához, szerkesztéséhez, ikon cserélni, stb. 
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28. kép 
Mappa beállítása ablak, Fájltípusok fül 
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4. táblázat 
kiterjesztések, és ezek leggyakrabban használt ikonjai 
 

 
A Microsoft Windowsban leggyakrabban használt kiterjesztések 

 

 
ARJ tomörített állomány 

 
AVI videó állomány 

 
BAK ideiglenes vagy biztonsági mentés allomány 

 
BAT futtatható fájl (alkalmazás) 

 
BMP képállomany 

 
COM futtatható fájl (alkalmazas) 

 
DOC szöveges dokumentum 

 

DOCX szöveges dokumentum (Word 2007-ben készült) 

 

EML elmentett e-mail (Outlook) 

 
EXE futtatható fájl (alkalmazás) 

 
GIF képállomány 

 
HTML internetes fájlformátum 
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HTM internetes fájlformátum 

 
JPEG képállomány 

 
JPG képállomany 

 
MID hangállomány 

 
MP3 hangállomány 

 
PDF szöveges dokumentum 

 
PPS prezentációs állomány (csak vetíthető) 

 
PPT prezentációs állomány 

 
PPTX prezentációs állomány (PowerPoint 2007-ben készült) 

 
RAR tomörített állomány 

 
RTF szöveges dokumentum 

 
SND hangállomány 

 
SWF animációs állomány 

 
 

TIF képállomány 
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TMP ideiglenes állomány 

 

TXT szöveges dokumentum 

 
WAV hangallomány 

 
WMA hangallomány 

 
WMV videó állornány 

 

XLS táblázatkezelővel készült fájl 

 
XLSX táblázatkezelővel készült fájl (Excel 2007-ben 

készült) 

 
ZIP tömörített állomány 

 
 
Tekintsük át a Sajátgép tartalmát. A megjelenő listában az aktuális mappa 

tartalmát láthatjuk. A megjelenő ikonok az almappákat és fájlokat jelölik. A belső 
mappák jelölése: egy sárga mappa; a fájlokat típusuk szerint más-más ikonok jelölnek. 
Azt, hogy egy mappa tartalmaz-e belső mappákat vagy fájlokat, úgy állapíthatjuk meg, ha 
az ikonjára vagy nevére duplán kattintva megnyitjuk azt.  
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29. kép 
A Sajátgép ablak 
 

 
 

A menüsor alatt elhelyezkedő terület, egy vagy több sorban elhelyezkedő, a 
munkavégzést megkönnyítő ikonsor az Eszköztárak (Toolbars).  

A Cím eszköztár legördülő menüben tartalmazza az elérhető meghajtók és logikai 
mappák listáját. Ha a fájlrendszer bonyolultsága miatt eltévednénk, itt mindig 
visszaléphetünk a gyökérkönyvtárainkhoz. A Szokásos eszköztár tartalmazza a 
fájlrendszerben való navigálás és műveletek gombjait. Az aktuális mappából a magasabb 
szintre visszalépni az Egy szinttel fel (Back) ikonra kattintva lehet.  
  A Sajátgép és a belőle nyíló objektumok tartalmát több nézetben tekinthetjük 
meg, amit az eszköztáron állíthatunk be. Az egyes nézetekben részletesebb képet, illetve 
jobban áttekinthető felületet kaphatunk. A következő nézet közül választhatunk: 
Minatűrök (Thumnails), Mozaik (Tiles), Ikonok (Icons), Lista (List), Részletek 
(Details). 
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30. kép 
Nézetek kiválasztása legördülő menüből 
 

 
 
 

Amennyiben a lista valamelyik oszlopa nem elég széles, az oszlopfejléceket 
elválasztó vonal húzásával állíthatjuk megfelelő szélességűre. Ha az elválasztó vonalra 
kettőt kattintunk, az oszlop szélessége automatikusan a legszélesebb bejegyzés hosszához 
igazodik.  
  Az oszlopfejlécre kattintva sorba is rendezhetjük az objektumokat (ábécérend, 
típus, méret, vagy az utolsó módosítás dátuma szerint). Újbóli kattintással válthatunk a 
növekvő és csökkenő rendezés között.  

A legtöbb művelet - használjuk akár a Sajátgép ablakot, a Windows Intézőt, vagy 
a legtöbb felhasználói programot - több módon is elvégezhető: 1. Menü segítségével. A 
programjainkban a rendelkezésre álló parancsokat logikusan felépített menüből 
választhatjuk ki. 2. Eszköztárról. A leggyakrabban használt parancsok ikonjai a menüsor 
alatti eszköztáron megtalálhatóak (pl. másolás, kivágás, beillesztés, nyomtatás, stb.) 3. 
Helyi menüvel. Az egér jobb gombjának lenyomásával az aktív objektumra vonatkozó, 
leggyakrabban használt parancsok listáját hívhatjuk elő. 4. Billentyűkombinációval. A 
gyakorlott felhasználók munkájának meggyorsítására szolgálnak a 
billentyűkombinációval előhívható parancsok, pl. másolás, beillesztés, nyomtatás, stb. 
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31. kép 
Menü használata a Microsoft XP-ben  
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32. kép 
Eszköztár használata a Microsoft XP-ben  
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33. kép 
Helyi menü használata a Microsoft XP-ben  
 

 
 
 

Meghajtók, mappák, fájlok tulajdonságai 
 
Egy fájl, mappa vagy meghajtó tulajdonságait a következő módon tudjuk megnézni: 
 
§ kattintsunk az eszköztár Tulajdonságok (Properties) gombjára  
§ használjuk a Fájl menü Tulajdonságok menüpontját (File > Properties) parancsot  
§ használjuk az ALT+ENTER billentyűkombinációt  
§ az egér jobb gombjával kattintva a megfelelő ikonra, válasszuk a helyi menüből a 

Tulajdonságok (Properties) parancsot.  
 

Meghajtók (helyi lemezek, cserélhető lemezek) tulajdonságai panelen láthatjuk 
először is a meghajtó nevét (a meghajtót jelképező ikon melletti mezőben), Típusát 
(Type) – Pl.: Helyi lemez, Cserélhető lemez, Kapacitását, valamint a Foglalt terület 
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(Used Space) és a Szabad területet (Free space) nagyságát számokkal, és 
kördiagrammal kifejezve.  
 
Lemezkarbantartó alkalmazások 
 

Ezek az alkalmazások az egyes lemezek tulajdonságai panelen, az Eszközök 
(Tools) panelről indíthatóak. 
 
Lemezellenőrzés (Error-checking) 
 

Megszüntethetjük a lemezen lévő logikai hibákat. Ezek a hibák áramszünet, 
illetve egyéb nem megfelelő kilépéskor (kikapcsoláskor-kikapcsolódáskor) 
keletkezhetnek. 
 
Lemeztöredezettség-mentesítő (Defragmention) 
 
 Munkánk, és az operációs rendszer működése során a háttértároló folyamatosan 
íródnak, és törlődnek dolgok. Törléskor a háttértároló azon részei kerülnek törlésre, ahol 
az adott tartalom megtalálható. Írás során viszont a számítógép azokra a helyekre ír, ahol 
üres helyet talál, és ez gondot jelent, ha nincs akkora összefüggő üres hely, mint 
amekorára szükség lenne. Ilyenkor az történik, hogy több helyre, feldarabolva kerülnek 
az adatok a háttértárra, az üres helyekre. Az ilyen adatok olvasásához több időre van 
szükség, mint ha ez egy helyen lenne tárolva, így csökken a számítógép sebessége. A 
lemeztöredezettség-mentesítő optimizálja ezt az eloszlást (a szabad helyek, és a 
felhasznált területek egymás mellé kerülnek). Ezért célszerű meghatározott időközönként 
(pl. havonta) lefuttatni ezt a programot. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 42 

34. kép 
A lemezkarbantartó alkalmazások 
 
 

 
 
 
 
A Megosztás (Sharing) fülre kattintva elérhetővé tehetjük a kiválasztott elemet 

(meghajtó, mappa) helyi hálózatunkon keresztül más felhasználók részére is.  
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35. kép 
Egy helyi lemez tulajdonságai  
 

 
 
 
 

A mappák tulajdonságai alatt panelen megjelenik a mappa Típusa (Type), Hely 
(Location) - pl.: C:\Windows, Mérete (Size), Lemezterület (Size on disk) és az, hogy 
milyen további mappákat és állományokat Tartalmaz (Contains) – pl.: 15 fájlt, 3 
mappát, Létrehozva (Created) valamint az Attribútumok (Attributes), amelyek 
lehetnek Írásvédett (Read only) és Rejtett (Hidden). Az írásvédett állományokat nem 
tudjuk módosítani, a rejtett állományok pedig nem láthatóak a legtöbb esetben. 
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36. kép 
Mappák tulajdonságai  
 

 
 

A fájlok tulajdonságai nagyban hasonlítanak a mappák tulajdonságaihoz, azzal a 
különbséggel, hogy a fájloknál nem szerepel Tartalmaz rész, illetve jelen van a Társítás 
(Opens With) opció. Emellett részletesebb információkat kapunk a létrehozásukról – 
Létrehozva (Created), a módosításukról - Módosítva (Modified) illetve a hozzáférés 
dátumáról – Hozzáférés (Accesed) 
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37. kép 
Fájlok tulajdonságai 
 

 
 
 
Feladatok: 
1. Nézzük meg, hogy mennyi szabad tárhely található a C meghajtón 
2. Jelenítsük meg a D:/ECDL/modul2 mappa tulajdonságait 
3. Vizsgáljuk meg, hogy hány fájlot és mappát tartalmaz a D:/ECDL mappa, valamint 
mekkora lemezterületet foglal el 
4. Tegyük írásvédetté a D:/ECDL/modul2/ecdl.txt állományt 
5. Oldjuk fel az írásvédettséget a D:/ECDL/modul2/leiras.txt állományról 
6. Töltsük ki a D:/ECDL/Modul2/Alapadatok.doc dokumentum erre a részre vonatkozó 
celláit, majd mentsük el a változásokat. 
 
Formázás (Format) 
 

A hordozható adattárolók (flash memória, CD-R/RW, stb.) az adatok fogadása 
előtt egy meghatározott rendszer szerint formázni kell. Ennél a műveletnél jelölik ki a 
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lemez nyomvonalait és szektorait, valamint rögzítik az ún. "root directory"-t és a "FAT" 
tartalomjegyzéket. A formázásnál minden esetleg már tárolt adat törlésre kerül (adatok 
átmentése). Az adattárolók nagy része ma már formázva kerülnek forgalomba. 

A gyorsformázás olyan formázási beállítás, amely új fájltáblát hoz létre a 
merevlemezen annak teljes törlése vagy felülírása nélkül. A gyorsformázás sokkal 
gyorsabb, mint a normális formázás, amely során a merevlemezen található összes 
korábbi adatot törli a rendszer. Formázás alkalmával tudunk nevet adni a Flash 
memóriának. 
 
Új mappák létrehozása  
 

Az új mappa létrehozása a következő módon történik: válasszuk ki azt a mappát 
(meghajtót), amelyen belül szeretnénk létrehozni az új mappát. Ezután kétféleképpen 
hozhatunk létre új mappát:  
 
§ A menüsorból: a Fájl >  Új  > Mappa  útvonalat követve (File > New > Folder) 
§ Jobb egérgomb segítségével (egy üres felületre klikkelve az ablakon belül): Új - 

Mappa (New > Folder) 
 

Ezután megjelenik az új mappa. A rendszer által felkínált név helyére gépeljük be 
a kívánt könyvtárnevet, majd üssük le az ENTER billentyűt. Új mappák létrehozásához 
ismételjük meg a műveletet. A mappák elnevezésére maximum 255 karaktert 
használhatunk, akár ékezeteket, szóközt is. Nem használhatjuk azonban a következő 
karaktereket: / ? * " | < >.  

 
Feladatok: 
1. Hozzunk létre egy „Szabadka” mappát a D:/ECDL/modul2 mappába 
2. Hozzunk létre egy mappát a Start menüben 
3. Ellenőrizzük, hogy megjelenik-e a Start menüben a létrehozott könyvtár és ezen belül 

a dokumentumok 
4. A D:/ECDL/modul2/Evszakok mappába hozzuk létre a tél, nyár, ősz, tavasz 

almappákat, ezekbe az almappákba pedig a következő almappákat: tél – december, 
január, február, tavasz – máricius, április, május, nyár – június, július, augusztus, ősz 
– szeptember, október, november. 

 
Új fájlok létrehozása  
 

Ha egy új fájlt szeretnénk létrehozni, válasszuk ki azt a mappát, amelyben tárolni 
kívánjuk. Ezután kétféleképpen hozhatunk létre fájlot:  
 
§ A menüsorból: Fájl menü > Új (New) >  fájltípus kiválasztása  
§ Jobb egérgomb segítségével (egy üres felületre klikkelve az ablakon belül): Új 

(New)  > fájltípus kiválasztása  
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A fájltípus kiválasztása után az új fájl megjelenik a kívánt helyen. Ezután 
nevezzük el. Az így létrehozott fájl azonban még üres. Kétszeri kattintással 
megnyithatjuk és szerkeszthetjük.  

Ezzel a módszerrel csak a leggyakrabban használt fájltípusokat hozhatjuk létre. 
Más fájlokat, pl. Office dokumentumokat kényelmesebb a megfelelő alkalmazással (pl. 
szövegszerkesztő program) létrehozni.  

 
Feladatok: 
1. Hozzunk létre egy szöveges (txt kiterjesztéssel) dokumentumot a 
D:/ECDL/modul2/Szabadka mappába „szabadka” fájlnévvel 
 
Állományok és mappák kijelölése 
 

A különböző állományműveletek elvégzésénél (másolás, mozgatás, törlés) az első 
lépés a kijelölés. Kijelölésre akkor is szükség van, ha egyszerre több mappára vagy 
állományra szeretnénk alkalmazni ugyanazon műveletet (pl. törölni). A kijelöléshez 
elegendő az adott állomány illetve mappa nevére vagy ikonjára klikkelni, egyszer. 
Gyakran előfordul azonban, hogy nem csak egy állományt, mappát szeretnénk kijelölni. 
Ebben az esetben a következő lehetőségekkel élhetünk: 

 
§ Amennyiben a kijelölésre szánt tartalmak egymás alatt vagy mellett helyezkednek 

el, akkor az egér bal gombját lenyomva tartva határozhatjuk meg a kijelni kívánt 
tartományt. Billenyűzet segítsével a SHIFT gomb folyamatos nyomvatartása 
mellett, a szövegkurzor segítségével, tudjuk meghatározni az adott tartományt.  

§ Egymástól független tartalmak kijelölése esetén a CTRL gomb folyamatos 
lenyomása mellett kell a megfelelő ikonokra klikkelni. 

§ Egy adott ablak összes állományának és mappájának a kijelöléséhez használjuk a 
CTRL+A billentyűkombinációt. 
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38. kép 
Kijelölés SHIFT segítségével 
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39. kép 
Kijelölés CTRL segítségével  
 

 
 
 
Feladatok: 
1. Jelöljük ki az első 4 mappát a D:/ECDL/modul2/Selection mappából 
2. Jelöljük ki minden harmadik mappát a D:/ECDL/modul2/Selection mappából 
 
 
Fájlok és mappák átnevezése  
 
Ha egy fájlt vagy mappát át kívánunk nevezni, először jelöljük ki. Ezután több 
lehetőségünk van:  
§ A Fájl menüből válasszuk az Átnevezés (File > Rename) parancsot  
§ Az egér jobb gombjával kattintva válasszuk a helyi menüből az Átnevezés 

(Rename) parancsot  
§ Kattintsunk újra (nem dupla kattintás)  

 
Ezután írjuk be az új nevet. A művelet folyamán az ESC billentyűvel bármikor 

visszaléphetünk., Enter gombbal pedig véglegesítjük a beírást. 
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Feladatok: 
1. Nevezzük át a D:/ECDL/modul2/Selection mappát Kijelölés mappára 
2. Cseréljük a D:/ECDL/modul2/New Text Document.txt fájl nevét Új Szöveges 
Dokumentum.txt névre 
3. Nevezzük át a szabadka.exe fájlot nepszamlalasi_adatok.exe névre 
 
A Vágólap (Clipboard) 
 
  A Vágólap a Windows által biztosított elkülönített memóriaterület. Egy kijelölt 
objektumot (szöveg, szövegrész, kép, hang, fájl, mappa, stb.) ide másolva bármely 
Windows-os alkalmazásba beilleszthetjük ezt, egymás után többször is. Egyszerre 
azonban csak egy objektum kerülhet a vágólapra. Az új objektum felvételével felülírjuk a 
régit. A vágólap tehát az adatok átvitelére használható egy programon belül, de 
programok közt is.  

A Windows egyik hasznos funkciója, amikor az egész képernyőt 
„lefényképezzük” a PrintScrn nyomógomb segítségével. Régen ez a billentyű pontosan 
azt tette, ami rá van írva – elküldte a nyomtatónak az aktuális szöveges képernyő 
tartalmát, és nyomtató kinyomtatta azt. Ma a PRINT SCREEN billentyű 
megnyomásakor a számítógép rögzíti a teljes képernyő képét, és a vágólapra, a 
számítógép memóriájába másolja azt. Az aktív ablak tartalmát az ALT+PrintScrn 
billentyűkombinációval másoljuk a Vágólapra.  

Ezt a képet a Vágólapról egy rajzolóprogramba (Paint) tudjuk másolni 
(kitöltéssel). Itt lehetőségünk van a képet módosítani, nyomtatni illetve elmenteni is. 
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40. kép 
A Vágólap „működési elve” 
 

 
 

Feladatok: 
1. Másoljuk az aktuális képernyőnk tartalmát a Vágólapra 
2. Másoljuk a vágólap tartalmát a Paint programba  
3. Mentsük el a képet JPG-be a D:/ECDL/modul2/ mappába „kepernyo” fajlnévvel  
4. Másoljuk az Asztal képét a D:/ECDL/Modul2/Alapadatok.doc dokumentumba a 
megfelelő helyre, majd mentsük el a változásokat. 
 
 
Fájlok és mappák másolása 
 

Másoláskor a következőképpen járunk el: jelöljük ki a másolandó fájlt vagy 
mappát. Az objektum vágólapra való másolásához használhatjuk: 
 
§ az eszköztár A fájl/mappa másolása ikonját  (Copy this folder/file) 
§ a Szerkesztés menü Másolás parancsát (Edit > Copy) 
§ az egér jobb gombjával kattintva a helyi menü Másolás (Copy) parancsát 
§ a CTRL+C billentyűkombinációt használva 

 
Ezután nyissuk ki azt a mappát, ahová az objektumot másolni kívánjuk. A 

beillesztéshez használjuk: 
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§ az eszköztár Beillesztés (Paste) ikonját  
§ a Szerkesztés menü Beillesztés parancsát (Edit > Paste) 
§ az egér jobb gombjával kattintva a helyi menü Beillesztés (Paste) parancsát  
§ a CTRL+V billentyűkombinációt.  

 
Feladat: 
1. Másoljuk D:/ECDL/modul2/Kijelölés/10mappa/15mapa mappát a 
D:/ECDL/modul2/Kijelölés/ mappába 
2. Másoljuk a D:/ECDL/modul2/Kijelölés/8mappa mappából a TextDocument.txt 
állományt a D:/ECDL/modul2/Kijelölés/ mappába 
3. Másoljuk (egyszerre) a D:/ECDL/modul2/Masolasok mappába a StaticHairKid.zip, 
leiras.txt és a ecdl-logo.jpg fájlokat a D:/ECDL/modul2 mappából 
4. Másoljuk (egyszerre) a D:/ECDL/modul2/Masolasok mappába a Tomorites és az 
EnobledPetFont mappát 
5. Készítsünk a D:/ECDL/modul2/ mappába egy BiztonsagiMasolat almappát. Másoljuk 
a nepszamlalasi_adatok.exe fájlot az újonan elkészített mappába. 
 
Fájlok és mappák áthelyezése  
 

Előfordulhat, hogy adataink tévedésből rossz helyre kerültek, vagy szeretnénk 
más helyre úgy átmozgatni, hogy eredeti helyükön ne maradjon róluk másolat. Fájlok 
vagy mappák áthelyezésekor a következőképpen járunk el: jelöljük ki az áthelyezendő 
fájlt vagy mappát. Az objektum vágólapra való másolásához használhatjuk: 
 
§ az eszköztár Kivágás (Cut) ikonját  
§ a Szerkesztés menü Kivágás parancsát (Edit > Cut) 
§ az egér jobb gombjával kattintva a helyi menü Kivágás (Cut) parancsát  
§ a CTRL+X billentyűkombinációt.  

 
Ezután nyissuk ki azt a mappát, ahová az objektumot átmozgatni kívánjuk. A 

beillesztéshez használjuk: 
 
§ az eszköztár Beillesztés (Paste) ikonját  
§ a Szerkesztés menü Beillesztés (Edit > Paste) parancsát  
§ az egér jobb gombjával kattintva a helyi menü Beillesztés (Paste) parancsát  
§ a CTRL+V billentyűkombinációt.  

 
Feladatok: 
1. Helyezzük át a D:/ECDL/modul2/Kijelölés/13mappa/0mappa mappáját a 
D:/ECDL/modul2/Kijelölés/ mappába 
2. Helyezzük át a D:/ECDL/modul2/Kijelölés/10mappa/PowerPointPresentation.ppt 
állományt a D:/ECDL/modul2/Kijelölés mappába 
3. A D:/ECDL/modul2/Athelyezes mappána helyezzük át a képeket, a tartalmuk szerint, a 
megfelelő almappákba. 
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Fájlok és mappák törlése  
 
A kijelölt fájl vagy mappa törlésére több eszközünk van, törölhetjük:  
 
§ a Delete billentyű használatával  
§ az eszköztár Törlés (Delete) gombjára kattintva.  
§ a Fájl menü Törlés parancsával  
§ az egér jobb gombjával kattintva a helyi menü Törlés parancsával  
§ húzzuk a kiválasztott elemet, elemeket az Asztalon található (és az Intéző bal 

oldali paneljében is elérhető) Lomtár ikonra  
 
Feladatok: 
1. Töröljük a D:/ECDL/modul2/Kijelölés/10mappa/15mapa mappát 
2. Töröljük a D:/ECDL/modul2/Kijelölés/8mappa mappából a TextDocument.txt 
3. Keressük meg a D: meghajtónk a october.rtf fájlot, majd töröljük véglegesen a 
mappával együtt. 
 
A Lomtár 
 

Az Asztalon található Lomtárba (Recycle Bin) kerülnek a számítógépünk 
merevlemezéről törölt fájlok és mappák. Ha ezeket a fájlokat később valóban 
szükségtelennek találjuk, innen törölhetjük azokat véglegesen, illetve a tévedésből törölt 
állományokat innen állíthatjuk vissza eredeti állapotukba.  

A Lomtár ürítéséhez (végleges törléshez) a helyi menü (jobb kattintás a Lomtár 
ikonjára) Lomtár ürítése (Empty Recycle Bin). parancsát kell választanunk. 

A Lomtár megtekintéséhez klikkeljünk duplán az Asztalon található Lomtár 
ikonra. A Lomtár tartalmát többi mappánkhoz hasonlóan kezelhetjük, onnan fájlokat 
törölhetünk, másolhatunk, stb.  

A Lomtárban található tartalmakat a kijelölésük után Fájl menü Visszaállítás 
(File > Restore), vagy az eszköztár Az összes elem helyreállítása/Ennek az elemnek a 
helyreállítása/A kijelölt elemek helyreállítása (Restore all items/Restore this 
item/Restore the selected items). 
 

§ A Lomtárba kerülő "törölt" fájlok valójában ugyanannyi helyet foglalnak el a 
háttértárolón, mintha le sem töröltük volna, így a valóban törölni kívánt fájlokat 
rögtön el lehet távolítani a Lomtárból is.  

§ A floppy (flash memória) lemezekről törölt állományok nem kerülnek be a 
Lomtárba, hanem azonnal megsemmisülnek.  

§ A Windows a törlési folyamat megkezdése előtt rákérdez, valóban törölni 
kívánunk-e. A Lomtár ikonra az egér jobb gombjával kattintva a Tulajdonságok 
(Properties) paranccsal állíthatjuk be a Lomtár viselkedését: kívánjuk-e a törlési 
jóváhagyás megjelenítését, mekkora lemezterületet szánunk a Lomtárba átkerülő 
fájlokra, illetve kívánjuk-e egyáltalán a Lomtárban ideiglenesen megtartani őket.  
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Ha egy állományt a merevlemezünkről biztosan törölni kívánunk, a SHIFT+DEL 
billentyűkombinációval törölve nem kerülnek a Lomtárba, hanem azonnal 
megsemmisülnek.  
 
41. kép 
A Lomtár tulajdonságai  
 

 
 

 
Feladatok: 
1. Állítsuk vissza a TextDocument.txt állományt. Ellenőrizzük, hogy a 
D:/ECDL/modul2/Kijelölés/8mappa mappába került-e 
2. Ürítsük ki a Lomtárat 
3. Töröljük a visszaállított TextDocument.txt állományt a SHIF+DEL segítségével. 
Ellenőrizzük, hogy a lomtárba került-e. 
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Hasznos szoftverek 
 
A Számológép 
 

A Számológép (Calculator) egy hagyományos számológép másolata a Windows 
rendszerben. Alkalmas az egyszerű matematikai műveletek kiszámítására. Indítása a 
Start menü > Programok > Kellékek > Számológép (Start > All Programs > 
Accessories > Calculator) útvonalat követve történik. Az indítás másik módja a Start 
menü Futtatás (Start > Run) menüpontját választva, a „calc” parancs begépelésével 
történhet. 

Használata is megegyezik egy hagyományos zsebkalkulátor kezelésével. Az 
adatokat bevihetjük a megfelelő nyomógombok leütésével (billentyűzet), illetve az egér 
segítségével, a megfelelő helyre klikkelve. A Nézet (View) menüben állíthatjuk be, a 
számológép megjelenítési formáját: Normál (Standard) vagy Tudományos (Scientific), 
megjelenésű legyen a számológépünk. Az alapműveleteket a következő karakterek 
helyettesítik: 

 
5. táblázat 
Az alapműveleteket jelölő karakterek 
 

szorzás * 
összeadás + 
kivonás - 
osztás / 

 
A billentyűzeten használhatjuk a számjegyeket (0-9), az alapműveletek 

billentyűit, az ENTER billentyűket (mely az egyenlőségjel megfelelője), az ESC 
billentyűt (a piros C jel, azaz a művelet törlése), és a BACKSPACE ( ) billentyűt.  
 
42. kép  
A Számológép 
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Feladatok: 
1. Számoljuk ki a Számológép segítségével a 583+224 és a 856*12 műveleteket. 
 
Total Commander 
 

A Total Commander az egyik legelterjedtebb fájlkekezelő szoftver. Ingyenesen 
letölthető a http://www.ghisler.com/download.htm linkről. A magyar verzió pedig a 
http://www.totalcommander.hu/letoltes linkről érhető el. 

Alkalmazható benne az összes Windowsben alkalmazott, fájlműveleteket 
megkönnyítő billentyűkombináció. A fájlműveletek egy részét elvégezhetjük az egér 
segítségével (másolás – fod és vidd módszer, kijelölés – jobb kattintás az állományra). 

Régi elnevezése Windows Commander volt. A Microsoft esetleges perrel való 
fenyegetése miatt került sor a név megváltoztatására. 

A program két ablakból áll. A műveletek itt is kijelöléssel, valamint az ablakok 
megfelelő beállításával kezdődnek (pl.: kijelölni a másolni kívánt állományt az egyik 
ablakban, a másik ablakot a megfelelő pozícióba állítani, ide történik a másolás) 

A leggyakrabban használt műveletek az ablak alsó részében találjuk meg, ezek 
elérhetőek egérrel, valamint a funkciógombok segítségével. Ezek a következők: 

 
F3 – Nézőke (View) 
F4 – Szerkesztés (Edit) 
F5 – Másolás (Copy) 
F6 – Áthelyezés, Átnevezés (Move) 
F7 – Új könyvtár (New Folder) 
F8 – Törlés (Delete) 
Insert – Kijelölés (Select) 
ALT + F4 – Kilépés (Exit)  

 
 Az F6-os funkciógombot használhatjuk áthelyezésre (különböző tartományú 
ablakok), vagy átnevezésre, ha mindkét ablak tartalma megegyezik (ugyanarra a 
könyvtárra mutat). Az állományok átnevezésénél ügyelnünk kell a kiterjesztések 
megőrzésére, mert ha ezt módosítjuk, akkor más programok (vagy egyik sem) fognak a 
fájlra asszociálni. 
 A program használata során hasznos billyentyű még az Enter, amellyel mappákat 
nyitunk meg, vagy fájlokat futtatunk, illetve a Backspace, amellyel egy lépést lépünk 
vissza a mappák hierarhijában. Gyakran használatos még a TAB nyomógomb, amelyet az 
ablakváltásra használunk. 
 A szoftver tartalmaz belső (beépített) kicsomagolókat a ZIP, ARJ, LZH, GZ, 
TAR, RAR és ACE formátumokhoz, valamint belső ZIP-csomagolót.  

A Becsomagolás műveleténél is az első lépés a becsomagolni kívánt tartalmak 
kijelölése. Ezután a másik ablakot kell a megfelelő helyre állíntani (ide fognak kerülni a 
becsomagolt állományok). Egyszerre több fájlot, illetve mappát is be tudunk csomagolni.  

A Fájl menü Becsomagolás (File > Pack) menüpontjával vagy ALT+F5 
gyorsbillentyű lenyomásával a becsomagolás folyamatát indítani. Ezután ki kell 

http://www.ghisler.com/download.htm
http://www.totalcommander.hu/letoltes
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választani a csomagolás formátumát. Érdemes a Beállítás (Configure) gombra is 
kattintani a kívánt formátumnál, mivel például a ZIP esetén is 0-tól 9-ig lehet tömörítési 
arányt választani. Ilyenkor érdemes a viszonylag nagyobb számítási teljesítményt 
igénylő, maximális 9-est beállítani, mivel így kisebb lesz a fájlméret. 
 A kicsomagolást gyakorlatilag az előző folyamt ellentéte. Ki kell jelölni azt az 
állományt, amelyet ki szeretnénk csomagolni, majd a Fájl menü Kicsomagolás (File > 
Unpack Specific Files) menüpontjára kell mutatni, vagy az ALT+F9 
billentyűkombinációt használhatjuk. További érdekesség, hogy a program ENTER-rel 
megnyitja a tömörített fájlt, amelynek tartalmát azután simán másolhatunk például F5-tel 
is.  
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43. kép  
A Total Commander programablak 

 

Feladatok: 
1. Jelöljük ki az első 4 mappát a D:/ECDL/modul2/Selection mappából 
2. Jelöljük ki minen harmadik mappát a D:/ECDL/modul2/Selection mappából 
3. Nevezzük át a D:/ECDL/modul2/Selection mappát Kijelölés mappára 
4. Másoljuk D:/ECDL/modul2/Kijelölés/10mappa/15mapa mappát a 
D:/ECDL/modul2/Kijelölés/ mappába 
5. Másoljuk a D:/ECDL/modul2/Kijelölés/8mappa mappából a TextDocument.txt 
állományt a D:/ECDL/modul2/Kijelölés/ mappába 
6. Helyezzük át a D:/ECDL/modul2/Kijelölés/13mappa/0mappa mappáját a 
D:/ECDL/modul2/Kijelölés/ mappába 
7. Helyezzük át a D:/ECDL/modul2/Kijelölés/10mappa/PowerPointPresentation.ppt 
állományt a D:/ECDL/modul2/Kijelölés/ mappába 
8. Töröljük a D:/ECDL/modul2/Kijelölés/10mappa/15mapa mappát 
9. Töröljük a D:/ECDL/modul2/Kijelölés/8mappa mappából a TextDocument.txt 
10. Állítsuk vissza a TextDocument.txt állományt. Ellenőrizzük, hogy a 
D:/ECDL/modul2/Kijelölés/8mappa mappába került-e 
11. Ürítsük ki a Lomtárat 
12. Töröljük a visszaállított TextDocument.txt állományt a SHIF+DEL segítségével. 
Ellenőrizzük, hogy a lomtárba került-e. 
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Microsoft Paint 
 

A Microsoft Paint egy egyszerűbb rajzprogram, amely egyszerűbb rajzok 
elkészítésére, illetve már meglévő rajzok, képek kisebb módosítására használható. 
Komolyabb módosításokra, retusálásokra, fényképek feldolgozásra, komolyabb rajzok 
készítésére már nem használható. 

A programot a következő elérési útvonalat követve tudjuk indítani: Start menü > 
Programok > Kellékek > Számológép (Start > All Programs > Accessories > 
Calculator). 

A Paint képernyőjének a felépítése hasonlít a többi a Windows alkalmazás 
képernyőjéhez. Legfelül a menüsor található, legalul az információs sor, felette a 
színpaletta helyezkedik el, középen találjuk a munkalapot. A munkalapra tudunk rajzolni, 
ennek mérete képenként változhat. A palettán választhatjuk ki a rajzolt objektumok 
(kör)vonal- és kitöltő színeit. Az eszköztáron pedig a rajzoláshoz szükséges kellékeket 
találjuk meg. 

Ezek az elemek kikapcsolhatóak, illetve bekapcsolhatóak a Nézet (View) 
menüben. 

Ha a módosítást vissza akarjuk vonni, akkor a Szerkesztés menüben kattintsunk a 
Visszavonás parancsra (Edit > Undo), illetve használjuk a CTRL+Z 
billentyűkombinációt. Mindig a három legutolsó változtatás hatása szüntethető meg.  

Ha mégis helyes volt a változatatásunk, akkor alkalmazzuk a Visszavontás 
parancs ellentetjét az Ismét (Repeat) parancsot vagy a CTRL+Y billentyűkombinációt. 
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44. kép 
A Paint programablak 
 

 
 
 

A pixelgrafikus rajzolóprogramokban a rajzolás a kitöltő és körvonalszínek 
kiválasztásával kezdődik. A kitöltő színt a legegyszerűbben a palettáról választhatjuk ki, 
az egér egyszeri (bal), kattintásával a megfelelő színre. Az egér jobb gombbal történő 
kattintásával pedig a kitöltőszínt határozzuk meg. A paletta melletti mintamező egyszerre 
mutatja a kitöltő és körvonal színét (az előtérben van a körvonalszín, háttérben pedig a 
kitöltőszínt jelző négyzetecske). 

 Előfordulhat azonban, hogy a paletta alapszínei nem megfelelőek (a színek 
árnyalatára van szükségünk). A színek szerkesztéséhez kattintsunk kétszer a megfelelő 
alapszínre, vagy a Színek menüben adjuk ki a Színek szerkesztése (Colors > Edit 
Colors)  parancsot. Kattintsunk az Egyéni színek definiálása (Define Custom Colors) 
gombra. Az egyéni színeket meghatározhatjuk értékek begépelésével Kontraszt (Hue), 
Telítettség (Sat), Fényerő (Lum), a másik értékskálát a Vörös (Red), Zöld (Green) és a 
Kék (Blue) színek aránya határozza meg. Egyéni színeket választhatunk a mezőre 
klikkelve is, a szín árnyalatait a jobb oldalon található skála segítségével határozhatjuk 
meg.  
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A kiválasztott színt a Hozzávétel az egyéni színekhez (Add to Custom Colors) 
gomb segítségével tudjuk felvenni az alapértelmezett színek sorába.  
 
45. kép 
Színek szerkesztése  

 

 
 

Ha egy színt már használtunk, a Szemcseppentő eszköz (Pick Color)    
segítségével újra felhasználhatjuk: egyszeres kattintással a vonal színét, jobb 
egérkattintással a háttérszínt állíthatjuk át olyanra, amilyen színű a szemcseppentővel 
kijelölt képpont.  

A rajzolási művelet első lépése a rajzolóeszköz kiválasztása. A Paint által nyújtott 
szolgáltatások: vonal, szabadkézi rajz, görbe, téglalap, sokszög, ellipszis, lekerekített 
sarkú téglalap rajzolása, és festékszórás. Az esetleg hibásan rajzolt elemeket a radírral 
törölhetjük.  

Az eszköztáron kattintsunk az Egyenes vonal rajzolása (Line) ikonra.  
A vonalvastagság kiválasztásához kattintsunk az eszköztár alján megjelenő választékból 
a megfelelőre.  
 
46. kép 
A vonalvastagság kiválasztására szolgáló panel 
 

 
 

A vonal színének kiválasztásához kattintsunk a palettán a megfelelő színre (a 
színeket a rajzolás előtt is megadhatjuk). A vonalat ezután az egérmutató elhúzásával 
rajzolhatjuk meg.  
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A vonal rajzolásakor az egér bal oldali gombját lenyomva az előtér, a jobb oldali 
gombját lenyomva a háttér színével rajzolhatunk. Vízszintes és függőleges vonalak, vagy 
45 fokos átlók rajzolásához az egér elhúzása alatt nyomjuk le, és tartsuk lenyomva a 
SHIFT billentyűt.  

Ceruza (Pencil) a következő ikonra klikkelv tudunk megvalósítani.   
Ha vonalvastagságot, ecsetformát is meg szeretnénk adni, kattintsunk a Ecset (Brush) 

ikonra.  Válasszuk ki a megfelelő színt a palettából, majd a vonal rajzolásához az 
egérmutatót az egérgomb nyomva tartása mellett húzzuk a megfelelő irányba. Mivel 
szabad kézzel zárt alakzatot nem tudunk készíteni, a háttérszínnek itt nincs jelentősége.  

Görbe (Curve) a következő ikon segítségével történik.  A vonalvastagság 
kiválasztásához kattintsunk az eszköztáron megjelenő választékból a megfelelőre, majd a 
vonal színének kiválasztásához kattintsunk a megfelelő színre. Az egérmutató 
elhúzásával rajzoljunk egy egyenes vonalat, majd kattintsunk arra az oldalra, ahol a görbe 
ívét el akarjuk helyezni, majd az egérmutató elhúzásával alakítsuk ki a megfelelő ívet. A 
görbéknek legalább egy ívvel rendelkezniük kell, azonban az ívek száma nem lehet több 
kettőnél. A második ív megrajzolásához az előbbi lépést kell megismételni. A görbék ívét 
(a vektorgrafikus rajzolóprogramoktól eltérően) itt nem tudjuk utólag megváltoztatni. A 
görbe rajzolásakor az egér bal oldali gombját lenyomva az előtér, a jobb oldali gombját 
lenyomva a háttér színével rajzolhatunk.  

 Az eszköztáron kattintsunk az Ellipszis (Elipse) ikonra.  
A vonal színének kiválasztásához a palettában kattintsunk a megfelelő színre. Ha az 
alakzat belsejét is ki akarjuk színezni, akkor az egér jobb oldali gombjával kattintsunk a 
megfelelő színre, majd válasszunk egyet az eszköztár alján látható kitöltési változatok 
közül.  Az ellipszis megrajzolásához a befoglaló téglalap szemben levő csúcsait kell 
megadnunk. Az egérgomb lenyomásával adjuk meg az egyik pontot, majd átlósan húzzuk 
el az egérmutatót, és a megfelelő ponton engedjük fel. Ha kört akarunk készíteni, akkor 
az egérmutató húzása alatt nyomjuk le, és tartsuk lenyomva a SHIFT billentyűt.  

Téglalap készítéséhez az eszköztáron kattintsunk a Téglalap rajzolása 

(Rectangle) ikonra.  Ha Kerekített sarkú téglalapot (Rounded Rectangle) akarunk 

készíteni, akkor az  ikonra kell kattintanunk. A vonal színének kiválasztásához 
kattintsunk a palettában a megfelelő színre. Ha az alakzat belsejét is ki akarjuk színezni, 
akkor kattintsunk a megfelelő színre az egér jobb oldali gombjával, majd válasszunk 
egyet az eszköztár alján látható kitöltési változatok közül. A téglalapot szemközti sarkok 
megadásával rajzolhatjuk meg: az egyik sarok megadásához kattintsunk a munkaterület 
megfelelő pontjára, majd az egérgombot nyomva tartva a téglalap megrajzolásához 
átlósan húzzuk el az egérmutatót a megfelelő irányba, majd engedjük fel az egérgombot.  
Négyzet rajzolásához a SHIFT billentyűt az egérmutató húzása alatt nyomjuk le, és 
tartsuk lenyomva.  

Sokszög rajzolása (Polygon) a következő ikon segítségével történik.   A 
palettában a megfelelő színre kattintva válasszuk ki a sokszög körvonalának színét. Ha a 
sokszög belsejét is ki akarjuk színezni, akkor az egér jobb oldali gombjával kattintsunk a 
megfelelő színre, majd válasszunk egyet a szerszámkészlet alján látható kitöltési 
változatok közül. A sokszög megrajzolásához húzzuk az egérmutatót a megfelelő 
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irányba, és a sarkoknál kattintsunk. A sokszög záró oldalának megrajzolásához duplán 
kell kattintanunk. Ha csak 45 és 90 fokos szögeket akarunk rajzolni, akkor az egér húzása 
alatt nyomjuk le, és tartsuk lenyomva a SHIFT billentyűt.  
 
47. kép 
Az elipszis, a téglalap és a sokszög kitöltésének meghatározása 
 

 
 

Kitöltés használatánál klikkeljünk az eszköztáron a Kanna ikonra (Fill With 

Color) , majd a palettában a kiválasztott színre. Ezután kattintsunk arra a területre 
vagy objektumra, amelyet ki akarunk tölteni. Ha a kitöltéshez az előtér színét szeretnénk 
használni, az egér bal oldali gombjával kell a területre kattintanunk. Lehetőségünk van a 
háttér színének használatára is, ehhez az egér jobb oldali gombjával kell a megfelelő 
területre kattintanunk.  Ha a kitöltendő alakzat nem zárt, akkor a program a rajzterület 
többi részét is beszínezi. A körvonal szakadásainak megkereséséhez kattintsunk a Nézet 
menüre, válasszuk a Nagyítás parancsot, majd kattintsunk a Nagy méretre (View > 
Zoom > Large Size) . Ha a rajzot ilyen módon felnagyítottuk, a rajzoló eszközökkel a 
szakadásokat (például egy vonallal) "befoltozhatjuk".  

Festékszóró (Airbrush) használatához klikkeljünk a következő ikonra ikonra. 

 A festékszóró segítségével úgy festhetünk, mintha egy festékszóró flakonját 
tartanánk a kezünkben: a rajzolóprogram véletlenszerűen, vagy előre meghatározott 
minta szerint rajzolja a képpontokat a rajzterületen. Az egyszerre beszórandó terület 
méretének módosításához kattintsunk az eszköztár alján látható méretek közül a 
megfelelőre (a festékszóró kiválasztása után jelenik meg). A festékszórás színének 
kiválasztásához kattintsunk a megfelelő színre. A festékszóráshoz az egérmutatót a 
megfelelő irányba kell húznunk. Az egér bal oldali gombját lenyomva az előtér, a jobb 
oldalit lenyomva a háttér színével tudjuk a festéket szórni.  
 
48. kép 
A festékkel beszórandó terület beállításai 

 
 

A törléshez a Radírt (Eraser/Color Eraser)tudjuk használni, amelyet az 

eszköztáron a következő ikon jelöl: . Ha kisebb vagy nagyobb méretű radírt akarunk 
használni, akkor az eszköztár alján válasszuk ki a legmegfelelőbb radíralakot (a radír 
kiválasztása után jelenik meg – négyzetek formájában). A kiválasztott háttérszín adja 
meg, hogy a radír milyen színt hagy maga után. A háttér színének módosításához az egér 
jobb oldali gombjával kattintsunk a palettán a megfelelő színre. Az egérmutató 
elhúzásával végezzük el a radírozást. Ha csak egyetlen színt akarunk megváltoztatni és 
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semmi mást, akkor az előtér színeként válasszuk azt a színt, amelyiket meg akarunk 
változtatni, a háttér színeként pedig azt, amelyikre az adott színt változtatni akarjuk. 
Kattintsunk a radír ikonra, majd az egér jobb oldali gombját lenyomva az egér 
elhúzásával változtassuk meg a színt. 
 
49. kép 
A radír méretének a meghatározása 
 

 
 
 

A Paint programban a rajzolás mellett lehetőségünk van szöveg bevitelére is. Az 

ehez szükséges ikont az eszköztáron találjuk . Ennek a műveletnek a neve: Szöveg 
beillesztése (Text). Az egérmutató átlós elhúzásával hozzuk létre a szövegkeretet, majd 
kattintsunk a szövegkeret belsejébe, és gépeljük be a szöveget. Szükség esetén helyezzük 
át a szövegkeretet, vagy módosítsuk a méretét. Ha meg akarjuk változtatni a szöveg 
színét, akkor kattintsunk a palettán a megfelelő színre. Ha a szöveget színes háttéren 

akarjuk elhelyezni, akkor kattintsunk az eszköztáron a  ikonra, majd az egér jobb 
gombjával kattintsunk kiválasztott háttérszínre. Ekkor a szövegkeret a megadott színű és 
méretű téglalapban eltakarja a korábban mögötte létrehozott rajzot. A szöveg 
tulajdonságait módosíthatjuk a Betűtípusok (Fonts) eszköztáron. Ha végeztünk a szöveg 
beírásával, annak beszúrásához kattintsunk a szövegkereten kívülre. 
 
50. kép 
A Betűtípusok eszköztár 
 

 
 

A készülő kép nagyítására két módszert használhatunk. A Nézet menüben 
mutassunk rá a Nagyítás (View > Zoom) parancsra, majd kattintsunk a Normál méret 
(Normal Size), Nagy méret (Large Size) vagy az Egyéni beállítás (Custom Size) 
menüpontok közül a számunkra megfelelőre. Emellett megkönnyíti a munkát az 

eszköztár Nagyító (Magnifier) ikonja.  Használatával kinagyíthatunk egy téglalap 
alakú területet, és itt (a szövegbevitel kivételével) tovább dolgozhatunk. Ebből a nézetből 
a jobb egérgombbal kattintva visszatérhetünk a normál nézethez. A nagyítás mértékét az 
eszköztárban határozhatjuk meg. 
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51. kép 
A nagyítás mértékének meghatározása az eszköztáron 
 

 
 
 

A képméret megváltoztatásához az Kép menüben kattintsunk a Attribútumok 
parancsra (Image > Attributes). Az Egység (Units) mezőben a megfelelő 
választógombra kattintva adjuk meg a szélességhez és a magassághoz használandó 
mértékegységet (hüvelyk, cm, képpont). Gépeljük be az Szélesség (Widht) és a 
Magasság (Height) mezőkbe a megfelelő értékeket. A beállított új értékek hatására az 
aktuális kép mérete módosul. Ha kisebb értéket adunk meg, mint amekkora a kép aktuális 
mérete, akkor a program a képet a jobb oldalon és alul a megfelelő méretre levágja.  

A képméret átméretezhető egér segítségével is a fogd és vidd módszerrel, a 
megfelelő helyre klikkelve. 
 
 
52. kép  
A képméret módosítása 
 

 
 

Négyszögletes terület kijelöléséhez kattintsunk az eszköztáron a  ikonra, majd 
húzzuk el az egeret átlósan a terület fölött. Szabálytalan alakú terület kijelöléséhez 

kattintsunk a szerszámkészletben az  ikonra, majd húzzuk el az egeret a terület körül. 
A kijelölést jelző négyszög eltüntetéséhez kattintsunk a területen kívülre. Azt, hogy a 
kijelölés háttérrel, vagy háttér nélkül történjék, szintén az eszköztáron határozhatjuk meg. 
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53. kép 
A kijelölés típusának a meghatárzása (háttérrel vagy anélkül) 
 

 
 

A Vágólap fent leírt használata nem korlátozódik a Paint programra: lehetőségünk 
van arra, hogy a Paint grafikát másolva azt például egy Word dokumentumba (vagy 
bármely Office alkalmazásba) beillesszük. 

Természetes enebben a programban is használhatjuk a megszokott 
gyorsbillentyűket a másolás (CTRL+C), kivágás (CTRL+X), és a beillesztés 
(CTRL+V) műveletének meggyorsítására. A fájlok megnyitása, mentése is a szokásos 
módon történik. 

 
Feladatok 
1. Készítsünk egy összetett rajzot, amelynél használunk különböző alakzatokatokat, 
különböző vonalakat, kitöltőszíneket, festékszórót, és szöveget. 
2. Fényképezzük le a D:/ECDL/szabadka.exe ablakot, vágjuk ki a megfelelő részt, majd 
írjuk alá (piros betűkkel): a 2002-es népszámlálási adatok szerint, mentsük el 
3. Nyissuk meg a  D:/ECDL/ecdl-logo.jpg képet, méretezzük át a rajzfelületet, és írjuk a 
kép alá, hogy Kishegyes 2009. 
4. Nyissuk meg a D:/ECDL/minta.jpg képet. Tüntessük el a „MINTA” szöveget a képről. 
Mentsük el „logo” név alatt az új képet 
 
Jegyzettömb (Notepad) 
 

Ez a program egy Windows alatti szövegszerkesztő, amelyet a Windows 
tartalmaz alapesetben. Gyakorlatilag egy elektronikus írógép egyszerűségét ötvözi 
nagyon minimális beállítási lehetőségekkel.  A következő útvonalat követve tudjuk 
indítani: Start > Programok > Kellékek > Jegyzettömb (Start > All Programs > 
Accessories > Notepad) 

A hagyományos főmenü, tartalma is teljesen hagyományos. A Jegyzettömb Fájl 
(File) menüje az alapvető fájlműveleteket tartalmazza: Új dokumentum létrehozása 
(New), Megnyitás (Open), Mentés (Save), Mentés másként (Save As), Oldalbeállítás 
(Page Setup), Nyomtatás (Print) és a Kilépés (Exit). 

 A Szerkesztés (Edit) menü tartalmazza a Vissszavonás (Undo), Kivágás (Cut), 
Másolás (Copy), Kitöltés (Paste), Törlés (Delete), Keresés (Find), Következő keresése 
(Find Next), (Replace), (Go To), Az összes kijelölése (Select All), Idő/Dátum 
(Time/Date). 

A Formázás (Format) menü Font menüpontjából ki tudjuk választani a 
megfelelő betűtípust, amelyet a program alkalmaz a teljes szövegre. 
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54. kép 
A jegyzettömb programablak 
 

 
 
Feladatok: 
1. Oldjuk fel az írásvédettséget a D:/ECDL/ecdl.txt állományról 
2. Nyissuk D:/ECDL/leiras.txt állományt 
3. Másoljuk a D:/ECDL/leiras.txt állomány szövegét a D:/ECDL/ecdl.txt állomány 
4. Nevezzük át a D:/ECDL/leiras.txt állomány D:/ECDL/regileiras.txt nevűre 
5. A D:/ECDL/ecdl.txt állományt mentsük el D:/ECDL/ujecdl.txt névvel 
6. A D:/ECDL/ujecdl.txt állomány szövegét módosítsuk Times New Roman, Normál 
(Regular) 12-es pontnagyságúra 
7. A D:/ECDL/ujecdl.txt állomány első sorába írjuk a Szabadka 2009. szöveget, hagyjunk 
ki utánna egy üres sort 
8. Keressünk rá a szövegben, hogy található-e „ICDL” rövidítés 
9. Cseréljük az „ICDL” szöveget „ECDL”-re 
10. Őrizzük meg a változásokat 
11. Keressünk a súgóban az egérrel kapcsolatos szöveget. Másoljuk a szöveget a 
jegyzettömbe, majd mentsük el a dokumentumot „mouse” név alatt 
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Billentyűk és billentyűkombinációk a Windows XP-ban 
 

6. táblázat 
Billentyűk és billentyűkombinációk a Windowsban 
 

 
Billentyűk 

 

 
törlés a lomtárba 

 
a szövegkurzor a sor utolsó karakterére állítása 

 
utasítás végrehajtása, sorváltás 

 
visszalépés 

 
a szövegkurzor sor elejére állítása 

 
a numerikus billentyűzet be- illetve kikapcsolása 

 
a szövegkurzor lap aljára állítása, lapozás egy oldallal lefelé 

 
a szövegkurzor lap tetejére állítása, lapozás egy oldallal 
felfelé 

  
a képernyő tartalmát másoljuk a vágólapra 

 
a Start menü előhívása 

 
helyi menü előhívása 

 
Billentyűkombinációk 

 
ALT+CTRL+DELETE Windows feladatkezelő előhívása (Windows Task Manager) 
ALT+CTRL alkalmazások (ablakok) közti váltás 
CTRL+A összes objektum kijelölése 
CTRL+C másolás 
CTRL+V kitöltés 
CTRL+X kivágás 
CTRL+ESC Start menü előhívása 
F1 segítség – általában más szoftverekben is 
F3 keresés 
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SHIFT+DELETE végleges törlés 
WIN+D asztal megjelenítése 
 
 
7. táblázat 
Angol szavak fordításai 
 

A Windows XP-ben leggyakrabban használt angol szavak magyar megfelelői 

Angol Magyar 
About Névjegy 
Accosseries Kellékek 
Always on Top Mindig látható 
Bold Félkövér 
Browse Tallózás 
Cancel Mégse 
Change Csere 
Click Kattintás 
Clipboard Vágólap 
Clock Óra 
Close Bezárás 
Control Panel Vezérlőpult 
Copy Másolás 
Cut Kivágás 
Default Alapértelmezett 
Desktop Asztal 
Documents Dokumentumok 
Edit Szerkesztés 
Explorer Intéző 
Favorites Kedvencek 
File Fájl 
Find Keresés 
Folder Mappa 
Font Betű 
Games Játékok 
Help Súgó 
Italic Dőlt 
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My Computer Saját gép 
Network Hálózat 
No Nem 
Page Setup Oldalbeállítás 
Paste Beillesztés 
Print Manager Nyomtatásvezérlő 
Program Manager Programkezelő 
Properties Tulajdonságok 
Recycle Bin Lomtár 
Refresh Frissítés 
Registry Bejegyzés 
Rename Átnevezés 
Run (Open) Futtatás 
Save Mentés 
Select Kijelölés 
Send To Küldés 
Separator Elválasztó 
Setup, Settings Beállítások 
Shortcut Icon Parancsikon 
Shut Down Kikapcsolása 
Sound Recorder Hangrögzítő 
Start Button Indítógomb 
Status Bar Állapotsor 
System Rendszer 
Taskbar Tálca 
Toolbar Eszköztár 
Undo Visszavonás 
View Nézet 
Wizard Varázsló 
Yes Igen 
 
 

A Vezérlőpult 
 

Bevezető 
 

Mindenkinek más az egyénisége, ízlése, más színeket, hangokat kedvel. A 
Windows nagymértékben támogatja a munkakörnyezet testre szabását. E beállítások 
legtöbbje a Start menü - Vezérlőpult (Start > Control Panel) menüpont alatt található. 
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Ez a logikai mappa elérhető a Windows Intézőből és a Sajátgép (My Computer) 
mappából is.  

A Vezérlőpult ikonjainak segítségével megváltoztatható a Windows XP 
megjelenése és működése. Ezek az ikonok a számítógép beállítási lehetőségeit jelölik. 
Továbbá innen (is) elérhető a számítógép Telefonos hálózati kapcsolatainak (például 
Internet), betűkészleteinek, nyomtatóinak, felügyeleti eszközeinek logikai mappája. A 
Vezérlőpul indítása után az eszköztáron a Váltás a klasszikus nézetre (Switch to 
Classic View) válthatjuk a át a Vezérlőpult megjelenítési formáját a hagyományos 
módra. A kategórianézet szintén az eszköztáron érhető el, a Váltás a kategórianézetre 
(Switch to Category View) feliratra klikkelve tudunk nézetet váltani, ha klasszikus nézet 
az aktuális beállítás. Kategórianézetnél az ikonok csoportosítva vannak rendeltetésük 
szerint. 

 
55. kép 
A Vezérlőpult – klasszikus nézet 

 

Billentyűzet 
 

A Vezérlőpult Billentyűzet (Keyboard) ikonjára kattintva állíthatjuk be, hogyan 
viselkedjen a billentyűzet a Windows-ban. Ezen a panelen beállíthatjuk a 
Karakterismétlést (Character Repeat). Meghatározhatjuk az első karakter ismétléséig 
eltelt időt a Hosszú (Long) – Rövid (Short) skálán az Első ismétlés előtti idő (Repeat 
delay) felirat alatt. A karakterismétlés sebességét az Ismétlési sebesség (Repeat rate) 
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felirat alatt található skálán határozhatjuk meg a Lassú (Slow) és a Gyors (Fast) felirat 
között. 
 
 
56. kép 
A Vezérlőpult – klasszikus nézet 

 

 
Területi és nyelvi beállítások 
 

A Területi és nyelvi beállítások (Regional and Language Option) kategóriában 
telepíthetünk több nemzeti billentyűzetkiosztást. Egyszerre használhatunk például 
magyar és angol billentyűzetkiosztást, s köztük billentyűkombinációval, vagy a Tálcán a 
kijelzőre kattintva, az egérrel válthatunk. 
 A Területi és nyelvi beállítások panelen a Nyelv fül alatt a Részletek gombra 
kattintva (Regional and Language Option >  Languges > Details) a szövegbevitelnél 
használatos billentyűzetkiosztás módosítását tudjuk elvégezni, illetve megtekinteni. A 
felső mezőben tudjuk kiválasztani az Alapértelmezett szövegbeviteli nyelvet (Default 
input language). Ez a billentyűzetkiosztás lesz aktív a Windows beindulásakor. A 
Hozzáadás (Add) gombbal tudunk új szövegbeviteli nyelvet hozzáadni, az Eltávolítás 
(Remove) gombbal pedig a listáról tudjuk eltávolítani az adott nyelvet. A 
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Billentyűzetbeállítás > Szövegbevitel nyelvének hívóbetűi  (Key Settings > Hot key 
for input language) panelen tudunk gyorsgombokat rendelni az egyes nyelvekhez. A 
Váltás a szövegbeviteli nyelvek között (Switch between input language) a listán 
haladunk egyesével (CTRL vagy bal ALT + SHIFT). Ha azonban gyakran váltunk 
szövegbeviteli nyelvek között, akkor ajánlatos egyedi gombkombinációkat rendelni az 
egyes nyelvekhez a Billentyűkombináció módosítása (Change key sequence) panelen 
tudjuk megtenni (pl.: bal alt + shift + 1). A magyar billentyűzetkiosztásnál ajánlott a 101 
nyomógombos beállítás. 
 
57. kép 
A Területi beállítások ablak 
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58. kép 
A Területi beállítások ablak, Nyelvek fül 
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59. kép 
A Területi beállítások ablak, Nyelvek fül, Részletek gomb lenyomása után megjelenő 
panel 

 

 

Feladatok:  
1. Távolítsuk el a magyar szövegbeviteli nyelvet, ezután vegyük újra fel a listára, úgy 
hogy bal CTRL+Shift+2 legyen  a billentyűkombinációja 
2. Alkalmazzunk CTRL+Shift+1 az angol, CTRL+Shift+3 a szerb billentyűzetkiosztásra 
 
A megjelenítés tulajdonságai 
 

Az Asztal megjelenítését a Start menü - Beállítások - Vezérlőpult – Képernyő 
(Display) ikonra kattintva változtathatjuk meg. Ugyanezt a párbeszédablakot az Asztalon 
az egér jobb gombjával kattintva, majd a Tulajdonságok (Properties) parancsot 
választva is előhívhatjuk.  

Témák (Themes) felületen egységesen módosítható az operációs rendszer 
általános megjelenítése (ablakok alakja színe, háttér, stb.). 
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A Háttér (Desktop) kategóriában kiválaszthatjuk az Asztal hátteréül szolgáló 
mintázatot és/vagy tapétát. Természetesen a felsorolt tapétákon kívül más hátteret is 
használhatunk, ezt a képfájlt a Tallózás (Browse) gombra kattintva kereshetjük meg. A 
kiválasztott képet megjeleníthetjük Középen (Center) Mozaik (Tile) formájában vagy 
pedig a Nyújtás (Stretch) parancsot alkalmazva. 

Háttérként egyedi színt is választhatunk a Szín (Color) legördülő menüből. Ha 
fekete hátteret választunk, akkor a hátteret a számítógép nem frissíti, így ez a művelet 
nem „terheli” a számítógép teljesítményét. 

A Képernyőkímélő (Screen Saver) kategóriában választhatunk képernyővédőt, s 
meghatározhatjuk, hogy ha a gépen nem dolgozunk, hány perc után induljon el. Az egyes 
képernyővédők működését a Beállítások (Settings) gombbal módosíthatjuk és a Teszt 
(Preview) gombbal próbálhatjuk ki. Ha egyedi képernyővédőket telepítünk, akkor ezek is 
felkerülnek erre a listára. Ha a monitorunk megfelel az Energy Star szabványnak, azt is 
megszabhatjuk, hogy a monitor mikor kerüljön alacsony energiafelvételű várakozó 
üzemmódba, és mikor kapcsoljon ki automatikusan.  

A Megjelenés (Appearance) kategóriában az Asztal és a rajta megjelenő 
objektumok színét és más tulajdonságait (méret, betűtípus) állíthatjuk be. Legegyszerűbb, 
ha egy kész mintát alkalmazunk. Megjegyzendő, hogy ha hátteret állítottunk be, az az 
Asztal itt beállított színét eltakarja majd, s csak az Asztal ikonjainak szövegmezőjében 
teszi láthatóvá.  

A Beállítások (Settings) kategóriában megváltozathatjuk a Képernyőfelbontást 
(Sreen resolution), a Színminőséget (Color quality), az egyszerre egy időben 
megjeleníthető színek számát. A Speciális (Advanced) gombra kattintva 
megtekinthetjük/módosíthatjuk videokártya és a monitor típusát, valamint itt van 
lehetőségünk további, az adott videokártya és monitor saját beállításainak hangolására, 
finombeállítások elvégzésére, a 3D tulajdonságok és a színkezelés beállítására.  
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60. kép 
A Megjelenítés tulajdonságai elnevezésű ablak 

 

 

 
Feladatok:  
1. Alkalmazzuk háttérképként  D:/ECDL/modul2/ecdl-logo.jpg képet középen 
megjelenítve 
2. Alkalmazzuk háttérképként  D:/ECDL/modul2/wallpaper.jpg képet nyújtva 
3. Válasszunk tetszőleges képernyőkímélőt, tetszőleges várakozási idővel 
4. Alkalmazzuk a Klasszikus Windows (Windows Classic) témát, fekete háttértszínnel, 
álítsuk vissza alaphelyzetbe a témát 
5. Válasszuk ki a 3D Flying Object képernyőkímélőt 1 perces időzítéssel 
6. Jelenítsük meg olyan képernyőkímélőt, amely a saját nevünket animálja 
7. Engedélyezzük a Windows XP képernyőkímélőt 
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Az egér beállításai 
 

Az egér beállításait a Start menü - Beállítások - Vezérlőpult ablak 
Egér (Mouse) ikonjára kattintva tudjuk módosítani.  

A Gombok (Buttons) kategóriában beállíthatjuk, hogy az egeret bal vagy jobb 
kézzel használjuk-e. A balkezes egér esetében a jobb- és baloldali gombok jelentése 
felcserélődik. Az ablak jobb alsó sarkában levő tesztterületen látható kis dobozra 
kattintva tesztelhetjük a dupla kattintás sebességét. Ha a kis dobozra kényelmesen kettőt 
kattintva nem történik semmi, a Dupla kattintás sebességét vegyük lassabbra, és 
próbálkozzunk újra. Ha a Windows időnként két külön kattintásunkat dupla kattintásnak 
értelmezi, vegyük gyorsabbra a kattintás sebességét.  

A Mutatók (Pointers) kategóriában az egérmutató külalakját változtathatjuk 
meg. Legegyszerűbb az előkészített sémák közül választanunk.  

Az egérmutató beállításai (Pointer Option) kategóriában az egér sebességét és 
az egér nyomvonal hosszát állíthatjuk be. Ez utóbbi eszköz az LCD kijelzős, hordozható 
gépeken hasznos, mivel a folyadékkristály nem képes olyan gyorsan követni a 
változásokat, mint egy hagyományos monitor, így az egér egy gyorsabb mozdításkor 
"elveszhet" a képernyőn. Hagyományos monitort használva azonban az egymás után 
húzódó egérmutatók látványa gyakran zavaró lehet.  

A Kerék (Wheel) fülön az egér görgőjével kapcsolatos beállításokat 
(érzékenység) tudjuk módosítani. 

A Hardver (Hardware) fülre kattintva az egér típusát lehet megváltoztatni. 
Ennek átállítását azonban inkább hagyjuk a rendszergazdára. A forgalomban lévő 
standard egerek legtöbbjét a Windows automatikusan felismeri, így a hardverbeállítások 
kézi megváltoztatására hétköznapi körülmények között alig van szükség.  
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61. kép 
Az Egér tulajdonságai 
 

 
Betűtípusok 

A Betűtípusok (Fonts) parancsikonra kattintva a WINDOWSFONTS mappát 
nyitjuk meg. Ebben a rendszermappában találhatóak az operációs rendszeren telepített 
betűtípusaink. A felsorolt fontkészleteket dupla kattintással tekinthetjük meg. Új 
betűtípus telepítése úgy történik, hogy ebbe a mappába másoljuk a telepíteni kívánt 
betűtípust. Az adott betűtípus eltávolítása a mappából történő törléssel történik meg. A 
betűtípusok kiterjesztése TTF vagy FOT. 

Feladatok:  
1. Telepítsük a D:/ECDL/modul2/EnobledPetFont mappában található ennobled.ttf 
betűtípust. Győződjünk meg róla, hogy tudjuk használni a telepített betűtípust 
2. Távolítsuk el a telepített betűtípust. Győződjünk meg róla, hogy eltűnt-e 
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62. kép 
A Betűtípusok mappa 

 

 
Dátum és idő 
 

Számítógépünk órája folyamatosan jelzi a pontos időt és dátumot. Ezt az órát mi 
is átállíthatjuk, a Start menü - Beállítások – Vezérlőpult – Dátum és (Date and Time) 
ikonra, vagy a Tálcán látható órára kettőt kattintva. Nem csak a dátum és az idő 
megadására van lehetőségünk, de megadhatjuk azt is, hogy melyik időzónában 
használjuk gépünket, illetve automatikusan áttérünk-e a téli/nyári időszámításra. Az idő 
és a dátum frissítését az Interneten található szerverről is elvégezhetjük.  
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62. kép 
A Dátum és az idő tulajdonságai panel 

 

 

 
Hangok 
 

A Vezérlőpult Hangok (Sounds and Audio Devices) ikonjára kattintva 
lehetőségünk van az egyes Windows, Windows Intéző és más (pl. Outlook) 
eseményekhez hangot rendelni vagy elvenni, illetve kész hangsémákat alkalmazni.  
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63. kép 
A Hangok és audioeszközök tulajdonságai panel 

 

 

 
Rendszer 
 

A Rendszer (System) vezérlőpult-ikonra (vagy jobb egérgombbal az Asztalon 
levő Sajátgép ikonra) kattintva a legteljesebb információkat nyerhetjük gépünkről.  

Az Általános (General) kategória írja le, milyen típusú az operációs rendszer és a 
számítógép, illetve ki a regisztrált tulajdonosa.  

A Számítógépnév (Computer Name) kategóriában tekinthetjük meg, és ha van 
rá jogosultságunk, módosíthatjuk számítógépünk nevét, hozhatunk létre egy-egy hálózati 
szegmenshez kapcsolható hálózati azonosítókat, felhasználónév-jelszó párokat tároló 
beállításokat.  

A Hardverprofil kategóriában létrehozhatunk hardverprofilokat: A 
hardverprofilok szabályozzák az illesztőprogramok betöltését, ha a hardver megváltozik. 
Előfordulhat például, hogy egy hordozható számítógéphez különböző hardveregységek 
állnak rendelkezésre, attól függően, hogy a számítógép asztali vagy hordozható 
üzemmódban működik. A Windows kizárólag a helyes profil számára szükséges hardver-
illesztőprogramokat tölti be.  
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A Speciális (Advanced) kategóriában szabályozhatjuk a számítógép 
teljesítményét befolyásoló beállításokat: az indítást, fájlkezelést, a virtuális memória 
méretét. Ha másként nem állítjuk be, a Windows a C: meghajtón hozza létre a virtuális 
memóra fájlját, az ún. swap fájlt (pagefile.sys).  
 
64. kép 
A Rendszertulajdonságok fül 
 

 

Területi beállítások 

Bizonyos alkalmazások a különböző, eltérő nemzeti beállítások (abc-rend, 
napszak, hónapok neve, pénznem, stb.) kezelésére is fel vannak készítve. A Windows-
ban mód van a magyar (vagy egyéb) nyelv és más nemzeti jellegzetességek beállítására, 
ami megkönnyíti a többnyelvű munkavégzést.  

Windows összetevők és alkalmazások hozzáadása és eltávolítása 
 

Ha szoftvert szeretnénk eltávolítani számítógépünktől, válasszuk a Vezérlőpulton 
a Programok telepítése/törlése (Add or Remove Programs) ikont. A 
párbeszédablakban jelöljük ki az eltávolítandó programot, majd kattintsunk a 
Módosítás/Eltávolítás (Change/Remove) gombra. A telepített szoftvereket kizárólag a 
Programok telepítése/törlése (Add or Remove Programs) panelból távolíthatju el. Így 
törlődnek azok a programrészek, amelyek a telepítés során más könyvtárba kerültek (pl 
Windows vagy Windows/system), megszűnnek az asszociációs kapcsolatok (pl. egy 
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médialejátszó), illetve telepítés során történt módosítások is visszavonódnak, törlődnek a 
program iconjai. 

Programokat szükséges telepíteni. Dokumentumokat (Excell, Word, PowerPoint), 
képeket, hangfájlokat egyszerűen másoljuk, illetve töröljük. 

 
65. kép 
Programok telepítése és törlése ablak 

 

 

Ha magához a Windows rendszerhez szeretnénk további alkotóelemeket 
hozzáadni vagy elvenni, válasszuk a Windows összetevők hozzáadása vagy eltávolítása 
(Add/Remove Windows Components) kategóriát. Itt választhatjuk ki a telepíthető, ill. 
már telepített Windows összetevőket.  

Feladatok: 
1. Távolítsuk el k a Kiskönyvtár alkalmazást 
2. Távolítsuk el a GoogleEarth alkalmazást 
 
Az Indítópult 

A gépünk bekapcsolása után gyakran van, hogy mindig ugyanazokat a 
programokat indítjuk el. Ésszerű, ha ezek a programjaink automatikusan indulnak el, 
ezzel is gyorsítva a munkakezdést. Ide kerülnek be a víruskereső programok önvédelmi 
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(auto-protect) elemei is, amelyek a Windows indulásával betöltődnek és a háttérben futva 
felügyelnek a rendszerünkre. Az automatikus programindításra egy speciális mappa, az 
Indítópult szolgál. Ennek helye: DOCUMENTS AND 
SETTINGS\FELHASZNÁLÓ\START MENÜ\PROGRAMOK\INDÍTÓPULT. Itt 
hozhatunk létre parancsikonokat a Windows-ba való bejelentkezéskor automatikusan 
indítandó programokhoz.  

66. kép 
Felhasználók adatainak a módosítása 
 

 

Kártékony programok 
 
A vírus 
 

A számítógépes vírus olyan program, amely saját másolatait helyezei el más, 
végrehajtható programokban vagy dokumentumokban. Rossz indulatú főképp, más 
állományokat használhatatlanná, sőt teljesen tönkre is tehet. A számítógépes vírusok 
működése hasonlít az élővilágban megfigyelhető vírus viselkedéséhez, mely az élő 
sejtekbe hatol be, hogy önmaga másolatait előállíthassa. Ha egy számítógépes vírus kerül 
egy másik programba, akkor ezt fertőződésnek nevezzük. 

A vírus csupán egyike a rosszindulatú szoftverek (malware) számos típusának. Ez 
megtéveszthető lehet a számítógépfelhasználók számára, mivel mára lecsökkent a 
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szűkebb értelemben vett számítógépes vírusok gyakorisága, az egyéb rosszindulatú 
szoftverekhez, mint például a férgekhez képest. 

Bár a számítógépes vírusok lehetnek kártékonyak (pl. adatokat semmisítve meg), 
a vírusok bizonyos fajtái azonban csupán zavaróak. Némely vírus késleltetve fejti csak ki 
hatását, például csak egy bizonyos számú gazdaprogram megfertőzése után. A vírusok 
domináns kártékony hatása az ellenőrizetlen reprodukciójuk, mely túlterhelheti a 
számítógépes erőforrásokat. 

Napjainkban (2008), az internet térhódításaval vírusok már valamivel kevésbé 
gyakoriak, mint a hálózaton terjedő férgek. 
 
Kémprogramok (spyware) 

 
Kémprogramnak (angolul spyware) nevezzük az olyan, főleg az interneten terjedő 

számítógépes programok összességét, amelyek célja, hogy törvénytelen úton 
megszerezzék a megfertőzött számítógép felhasználójának személyes adatait. 

Számítógépes értelemben a trójai faló (röviden trójai – angolul trojan) egy olyan 
program, ami mást tesz a háttérben, mint amit a felhasználónak mutat. 

 
Féreg (worm) 

 
Egy számítógépes féreg (worm) egy számítógépes vírushoz hasonló 

önsokszorosító számítógép program. Míg azonban a vírusok más végrehajtható 
programokhoz vagy dokumentumokhoz kapcsolódnak hozzá illetve válnak részeivé, 
addig a férgeknek nincs szükségük gazdaprogramra, önállóan fejtik ki működésüket. A 
férgek gyakran a számítógépes hálózatokat használják fel terjedésükhöz. 
 
Vírusirtók (antivírusok) 
 

A vírusok ellen megoldás lehet, ha van a számítógépünkön telepítve vírusirtó 
program, ami állandóan figyeli a rendszert (letöltött és indított programokat, emaileket). 
A kártékony programok másik fajtája ellen a spyware (kémprogram) kereső software-ek 
segítenek. Mindezeket gyakran, általában hetente vagy akár naponta frissíteni szükséges a 
hatékony működéshez. Legismertebb antivírusok szoftverek a következők: Kaspersky, 
Avast, Avira, AVG. 

A vírusirtó szoftverek két alapelven működnek. Az első az úgynevezett reaktív 
védelem, ami az úgynevezett vírusdefiníciós adatbázison alapszik. Ebben az esetben a 
vírusirtó szoftver egy adatbázisból azonosítja a kártevőket. Az adatbázist a vírusirtó 
szoftver gyártója rendszeresen frissíti, a frissítéseket a legtöbb vírusirtó szoftver 
automatikusan letölti az internetről. 

A második – és napjainkban egyre fontosabb – védelmi módszer az úgynevezett 
heurisztikus vírusvédelem. Ebben az esetben a vírusirtó a beépített analizáló 
algoritmusok (mesterséges intelligencia) segítségével azonosítja a vírusokat. A módszer 
azért nagyon fontos, mert sokszor több nap telik el egy új vírus megjelenésétől addig, 
amíg a vírusirtó program gyártója az ellenszert elkészíti, és beépíti a vírusdefiníciós 
adatbázisba. A vírusirtó szoftvernek ilyenkor frissítenie kell magát az internetről, és csak 
ezután nyújt védelmet az új vírusok ellen. A heurisztikus módszereket is alkalmazó 
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modern vírusirtók viszont addig is védelmet nyújtanak a legtöbb kártevő ellen, amíg az 
ellenszer elkészül. 
 Amikor a víruskereső észeleli a kártékony programot, akkor több lehetőséget 
kínál fel: törlés, karanténba helyezés, áthelyezés, kihagyás. Általában a törlés a javasolt 
művelet. 

A számítógépre telepített tűzfal program megvédheti rendszerünket az illetéktelen 
betörési kísérletektől is amellett, hogy a vírusok hálózati fertőzését is megakadályozhatja. 
A tűzfal (angolul firewall) a számítástechnikában egy szoftveres vagy hardveres 
architektúra, amelynek célja annak biztosítása, hogy a hálózaton keresztül egy adott 
számítógépbe ne történhessen illetéktelen behatolás. 

Mit tehetünk, hogy elkerüljük a vírusfertőzést? 
 
 Az elővigyázatosság az vírusfertőzések legnagyobb százalékát képes megfékezni. 
A vírusok „melegágya” az egyes nem legális honlapok, valamint a cserélhető lemezek. 
Ezen elemek használatánál kell fokozattan figyelni kell a vírusokra utaló 
tevékenységekre. Fontos még az is, hogy az ismeretlen küldőtől származó üzeneteket 
(MSN), és a e-mailek csatolmányait ne futassuk. Az utóbbi időben azonban megjelentek 
olyan vírusok, amelyek üzeneteket küldenek a fertőzött meghasználó „nevében”, a 
felhasználó címlistájában szereplő felhasználóknak. Ezt figyelembe véve fontos az is, 
hogy az ismert címzettől származó üzenetek illetve e-mailek, amelyek ismeretlen 
honalpcímet tartalmaznak, és általában angol nyelvűek további fokozott veszélyforrás 
lehet. 
 Az elővigyázatosság mellett fontos, hogy a számítógépen legyen aktív (futó) 
víruskereső, amelynek az adatbázisa rendszeresen frissített. A tűzfal (firewall) 
alkalmazása engedélyezése, amely szintén gátat szab a vírusok terjedésének. 
 

Tömörítés 
 

Eljárás egy számítógépes állomány terjedelmének csökkentésére. A tömörítés 
főleg adatátvitelnél és tárolásnál előnyös. Lényeges különbséget tenni a veszteségmentes 
és veszteséges tömörítések között. Az első esetben a visszafejtés (kitömörítés) után ismét 
az eredeti állományt hozzuk létre. A második lehetőség a kép-, hang- és videóállományok 
kevésbé fontos (érzékszerveink számára felfoghatatlan) részeinek kiszűrésén alapszik: 
ezek a tömörítések (pl. avi, jpeg, mpeg, mp3 stb.) veszteségesek, azaz a tömörített fájlok 
az eredetinél kevesebb információt tartalmaznak.  

A tömörítő eljárások segítségével adatainkat olyan alakra hozhatjuk, amelyeknek 
kisebb az adatmennyisége, mint az eredetinek. Tehát kisebb helyet foglal az 
adathordozón, rövidebb idő alatt továbbítható a hálózaton. 

 
A tömörítés általában veszteséges, vagy veszteségmentesen történik: 
 
§ A veszteséges tömörítés olyan kódolás, aminek eredményeként létrejött kódolt 

jelhalmaz sokkal rövidebb mint az eredeti, azaz kisebb az adatmennyisége, de a 
tömörített adathalmazból nem állítható vissza tökéletesen az eredeti, csak jó 
közelítéssel, tehát információt vesztünk, de nem sokat. Így tömörítjük például a 
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digitális fényképeket, hangokat, mozgóképeket. Ezeknél nem annyira fontos a 
tökéletes visszaállítás. (ezeket az eltéréseket a szem és a fül nem is érzékeli.). 
Néhány ilyen tömörítési forma: MP3 (hang), JPEG (kép), MPEG (mozgókép). 

§ A veszteségmentes tömörítés olyan kódolás, aminek eredményeként létrejött 
jelhalmaz, rövidebb mint az eredeti, azaz kisebb az adatmennyisége és a 
tömörített adathalmazból tökéletesen visszaállítható az eredeti adatmennyiség. 
Nem vesztünk információt. Így programokat, dokumentumokat tömörítünk, 
hiszen ezeknél fontos a tökéletes visszaállítás. 

 
 A tömörítés mértéke nem csak a tömörítési eljárástól, hanem az adathalmaz 
tulajdonságától is függ. Például: vannak-e ismétlődő adatok, vannak-e más 
szabályszerűségek, az egyes jelek vagy jelcsoportok milyen gyakorisággal fordulnak elő. 
A hosszú gyakori jelcsoportokat lehet helyettesíteni egy rövid kóddal, ezt a hétköznapi 
életben is gyakran megtesszük. 

A tömörítőprogramok hatékony eljárásokat alkalmaznak. Elemzik az állomány 
szerkezetét, és annak függvényében határozzák meg a tömörítési eljárást. Legismertebb 
tömörítési módok: ZIP; ARJ; RAR. 

Tömörítés elméletben 
 

Mivel mindenféle adatot digitálisan kódolunk, elég foglalkoznunk egy tetszőleges 
számsorozattal, pl.: 3 5 5 5 5 5 5 2 2 7 7 7 7 számsor 13 db egyjegyű számból áll. Ezt a 
következőképpen kódoljuk: balról haladva adjuk meg a számot, és azt, hogy hányszor 
ismétlődik. Az eredmény: 3 1 5 6 2 2 7 4, ez 8 db szám, tehát 8/13 arányban tömörítettük 
az eredeti adatsort, ami egyértelműen visszaállítható.  

Képek esetében gyakori, hogy sok azonos színű pont van egymás mellett, így 
jelentős rövidítést érhetünk el.  Például adott egy kép-fájl, melyben csak összesen egy kör 
van és semmi más. Ezt egy átlagos képszerkesztő program bitenként tárolja el. 
Gyakorlatilag minden egyes képpontot egy pár byte tárol el. Éppen ezért itt rengeteg az 
üres hely, ami nem tárol semmit. A tömörítőprogram megszámolja, hogy hány darab 
egymás utáni üres hely van a képen és a rengeteg felesleges byte helyett egyszer kiírja az 
üres hely kódját és azt is leírja, hogy hány üres hely volt a fájlban. Szövegfájl esetén egy 
adott szókapcsolat vagy szövegrészlet sokszor előfordulhat. Ekkor a tömörítő csak egy 
esetben írja le teljes terjedelmében a gyakran ismétlődő kifejezést, mivel másodszor csak 
azt jegyzi fel, hogy hol volt előzőleg a szókapcsolat és milyen hosszú. 

Tömörítés gyakorlatban 
 

A Windows XP-ben a tömörítés elérhető a helyi menü segítségével (egy vagy 
több elemre alkalmazva) a Küldés > Tömörített mappa útvonalon (Send to > 
Compressed (Zipped) Folder). A kicsomagolás szintén a helyi menü Extract All 
parancsával történik. 
 
Feladatok: 
1.  Tömörítsük a D:/ECDL/modul2/Tomorites állományait ZIP tömörítéssel. Figyeljük 
meg azt hogy hol jelentős méretcsökkenés 
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2. Tömörítsük a D:/ECDL/modul2/Tomorites mappát ZIP tömörítéssel 
3. Csomagoljuk ki a D:/ECDL/modul2/StaticHairKid.zip állományt 
4. Tömörítsük a D:/ECDL/modul2/tomoriteni.txt, D:/ECDL/modul2/tomoriteni1.txt és a 
D:/ECDL/modul2/tomoriteni2.txt fájlokat egy zip fájlba, majd helyezzük át a 
D:/ECDL/modul2/Tomoritett mappába. 
5. Csomagoljuk ki a txt fájlokat 
6. Csomagoljunk ki egy tetszőleges elemet a D:/ECDL/modul2/7 Best  National 
Geographic Screensavers mappából. Alkalmazzuk ezt a fájlot képernyőkímélőként. 

 
 

Alkalmazás, amely nem válaszol 

 Az egyes alkalmazások, amelyek nem válaszolnak programhiba, lefagyás, illetve 
általános védelmi hiba esetén jelentkezhetnek (nem ritka eset). Ilyenkor ha lehetőségünk 
van rá nyomjuk meg az Alt+Ctrl+Del billentyűkombinációt, ezután megjelenik a 
Windows Feladatkezelő (Windows Task Manager), amelyben az Alkalmazások 
(Aplication) fülnél megtekinthetjük az alkalmazásokat, és azok álapotát. Azok az 
alkalmazások jelentik ilyenkor a gondot, amelyeknél a Nem válaszol (Not Responding) 
felirat jelenik meg az Állapot (Status) oszlopban. Ezeket a programokat kell bezárni a 
úgy, hogy először kijelöljük, majd a Feladat befejezése (End Task) gombra klikkelünk. 
Esetleg bezárhatjuk azokat az alkalmazásokat is, amelyek működnek, de nem 
szükségeseket az adott tevékenységünkhöz („lefoglalják a gépet”). A Folyamatok 
(Processes) fülnél bezárhatjuk az egyes szükségtelen folyamatokat is. 
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67. kép 
A futó alkalmazások áttekintése – Windows Feladatkezelő 

 

 

Biztonsági másolatok készítése 

Értékes adatokat, és sok időt és energiát veszíthetünk el, valami folytán törlődnek 
illetve sérülnek a dokumentumaink. Ez bekövetkezhet: hardverhiba (tönkremegy a 
merevlemez), vírusaktivitás alkalmával, illetve a felhasználó figyelmetlensége miatt is. 
Biztonsági másolat készítése a fontos dokumentumainkról ezekben az esetekben megvéd 
bennünket az adataink teljes elvesztésétől. A biztonsági másolatot ajánlott egy külső 
meghajtóra készíteni: CD, DVD, külső merevlemez, flash memória. 
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Nyomtató beállításai  

Azzal, hogy az egyes felhasználói programokban (szövegszerkesztő, 
táblázatkezelő, stb.) hogyan tudunk nyomtatni, a további modulokban foglalkozunk majd. 
Ahhoz azonban, hogy programjainkban nyomtathassunk, telepítenünk kell 
számítógépünkre egy nyomtatót. A Start menü - Beállítások - Nyomtatók parancsra 
kattintva nyissuk ki a Nyomtatók mappát (Start > Control Panel > Printers and 
Faxes). 

Helyi nyomtató telepítése  
 
  A Nyomtatók mappában indítsuk el a Nyomtató hozzáadása (Add Printer) 
varázslót. Válasszuk ki, hogy helyi vagy hálózati nyomtatót telepítünk-e. Ha Plug and 
Play kompatibilis nyomtatónk van, a Windows automatikusan megpróbálja érzékelni, és 
telepíti a szükséges meghajtó-programokat. Ezután válasszuk ki, melyik portra 
csatlakozik az új nyomtatónk.  
 

 
68. kép 
Helyi nyomtató telepítése  
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69. kép 
A csatlakozási port kiválasztása 
 

 
 

 
A harmadik lépésben ki kell választani ki a nyomtatótípust, amelyet telepíteni 

kívánunk. Ha a listában nem szerepel, akkor a Saját lemez (Have Disk) gombra kell 
klikkelni. Ekkor a gyártótól a nyomtatóval együtt kapott telepítőlemez(ek)re lesz szükség. 
Ha a típuslistában megtalálható az általunk használt nyomtató, akkor a Tovább (Next) 
gombra kell kattintani. Nevezzük el a nyomtatónkat tetszés szerint. A telepítő ezután a 
gépre másolja a nyomtatót vezérlő illesztőprogramokat. Nyomtassunk ki egy tesztoldalt, 
ezzel ellenőrizve, hogy a számítógép és a nyomtató közti kommunikáció megfelelő-e.  
 
70. kép 
A nyomtató hozzáadásának harmadik lépése 
 

 
 

Ha a telepítéssel végeztünk, az új nyomtató megjelenik a Nyomtatók mappában.  
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Hálózati nyomtató telepítése  
 
 Manapság szinte nincs olyan munkahely, ahol a számítógépeket ne hálózatba 
kötve használnák. Ennek több oka van. Az egyik ok, hogy vannak olyan eszközök, 
amelyek drágák, és nem lenne gazdaságos, ha minden felhasználó gépénél lenne ilyen 
eszköz. Ilyenek például a nyomtatók: gazdaságosabb, ha egy szervezet egy nagy 
teljesítményű, gyors lézernyomtatót vásárol, amit dolgozói a hálózaton keresztül 
használnak, mint ha minden egyes felhasználó gépéhez egyszerűbb és olcsóbb nyomtatót 
vásárolnának.  
 Ha  hálózati nyomtatót használunk, előfordulhat, hogy magunknak kell azt 
telepíteni. A Nyomtató hozzáadása varázslót elindítva válasszuk a Hálózati nyomtató 
opciót. Ezután a hálózati nyomtató elérési útját kell megadnunk. Ha nem tudjuk fejből, a 
hálózaton megkereshetjük a kívánt nyomtatót.  
 
80. kép 
A hálózati nyomtató telepítésének első lépése 
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81. kép 
A hálózati nyomtató megkeresése 

 

 
 

A varázsló ezután elvégzi az illesztőprogramok telepítését, és (ha kérjük) 
tesztoldalt nyomtat. Ezután az új nyomtató megjelenik a Nyomtatók mappában.  

Nyomtatótulajdonságok, megosztás  
 
  A Nyomtatók mappában a nyomtató ikonjára jobb egérrel kattintva (vagy a fájl 
menüben) a Tulajdonságok (Properties) paranccsal módosíthatjuk a nyomtatónk 
beállításait. Mivel a nyomtatóbeállítás módja típusonként eltér, ezért csak a legfontosabb 
funkciókat tekintjük át.  

Az Általános (General) kategória lehetőséget ad arra, hogy tesztoldalt 
nyomtassunk, illetve beállítsuk, milyen elválasztó oldalt szeretnénk nyomtatni 
dokumentumaink között (Ez akkor hasznos, ha nagy mennyiségben, több dokumentumot 
nyomtatunk egymás után, vagy nyomtatónkat megosztottuk).  
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82. kép 
A nyomtató tulajdonságai 
 

 
 

A többi kategóriában módosíthatjuk a festékfelhasználás beállításait, a használt 
illesztőprogramot, engedélyeket, rendelkezésre állás idejét, stb. A legtöbb nyomtató 
esetében megadhatjuk, milyen felbontással, képpont-sűrűséggel nyomtasson, valamint a 
festékfelhasználást is módosíthatjuk (takarékos üzemmód). Továbbá módosíthatjuk a 
használt papír méretét és minőségét, illetve hogy hogyan adagoljuk azt (kézi, automata, 
ill. melyik papíradagoló tálca).  

Számítógépünk erőforrásait a (mappákat, nyomtatót) Windows XP-ben elérhetővé 
tudjuk tenni a helyi hálózatban dolgozók részére. Ezt nevezzük megosztásnak.  
A nyomtatónk megosztásához kattintsunk a Megosztás (Sharing) fülre. A megosztási 
név lesz az a név, amelyet a hálózati felhasználók látni fognak (ez különbözhet a helyileg 
használt névtől).  

Végül pedig megadhatunk jelszót a nyomtató eléréséhez, így tudjuk szabályozni, 
hogy csak azok nyomtathassanak rajta, akik a jelszót ismerik. Ha nem adunk meg jelszót, 
bárki tud nyomtatni a printerünkön.  

Ha egy felhasználói programunkból nyomtatunk, a nyomtatott dokumentum 
megjelenik a nyomtatási sorban. Eközben a Tálcán megjelenik a nyomtató ikonja. Ha a 
Nyomtatók mappában, vagy a Tálcán kettőt kattintunk a nyomtatónkra, a hozzá tartozó 
nyomtatási sor válik láthatóvá. A Nyomtató menüben vezérelhetjük a nyomtatás 
folyamatát, a nyomtatási sort szüneteltethetjük, vagy törölhetjük. A sorban várakozó 
dokumentumok közül egyenként is törölhetünk. Természetesen ez a művelet nem érinti 
az eredeti dokumentumot.  

Ha több (hálózati) nyomtató van telepítve a számítógépünkre, akkor ki tudjuk 
választani azt, hogy ezek közül melyik jelenjen meg alapértelmezettként a különböző 
szoftverekben (melyik legyen elsődlegesen felkínálva). Ezt a nyomtató mappában az 
aktuális nyomtató helyi menüjében a Beállítás alapértelmezettként (Set as Default 
Printer) parancs segítségével tudjuk módosítani. Az alapértelmezett nyomtatót itt fekete 
körben fehér pipa jelöli. 
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Feladatok: 
1. Nyomtassuk fájlba a D:/ECDL/Modul2/Alapadatok.doc fájlot a D:/ECDL/Modul2/ 
mappába 


